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Limitations on Use

For Research Use Only (RUO). Not for use in diagnostic procedures.

Hyperlink Disclaimer

Bruker DaltonikGmbH makes no expresswarranty, neither written nor oral, and is neither
responsible nor liable for data or content from the linked Internet resources presented in
this document.

Contact

Contact your local Bruker Daltonics representative for service and further information.

USA Germany
Bruker Daltonics Inc
40Manning Road
Billerica, MA 01821
USA

Bruker DaltonikGmbH
Fahrenheitstraße 4
28359 Bremen
Germany

Phone: +1 978 6633660 Phone: +49 421 2205-345
Fax: +1 978 6675993 Fax: +49 421 2205-390
Internet: www.bdal.com Internet: www.bdal.de

Service Support

Phone: +1 978 6633660-1445

E-mail: service-support@bdal.com

Service Support

Phone: +49 421 2205-350

E-mail: maldi.sw.support@bdal.de
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Typographic and Application Conventions

These conventions list the font styles used for indicating specific graphical user interface
(GUI) elements (e.g. menu Items).

They also list the meanings of terms used to describe user interactions with the graphical
user interface of software (e.g. right-click).

Typographic Conventions

File and Directory Names and Paths

File and directory names and paths are written in regular type.
Example: "Go to the C:\Bruker\solariXcontrol\test directory and open the file test_
1.txt."

GUI elements

GUI (graphic user interface) elements are options that are available in software that
enable a user to interact with the software without using the keyboard.
Typical GUI elements include windows, menus, menu options, drop-down lists, and
buttons.

l Names of windows are written in regular, capitalized type.

l Names of text entry fields and buttons are written in bold type.

Example: "In the New Digest window, type aName (obligatory) andNote
(optional) and clickNext."

l GUImenus and command names are written in bold type.

Example: "SelectWindow > Show View > LC-MS Survey."

Keyboard

References to keys on the keyboard are written in UPPER CASE.
Example: "Press ALT+F4."

Publications

References to electronic and printed documents are written in italic type.
Example: "See theProteinScape Administrator Manual for more details."
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URLs

UniformResource Locators (URLs) are written in italic type. The protocol name (for
example, http://) is usually omitted.
Example: "Visit www.bdal.com for more details."

Keyboard Conventions

Press

Use the indicated key(s) on the keyboard.Whenmodifier keys (e.g.SHIFT,ALT,
CTRL) are indicated, keep them pressed while pressing the other key.
Example: "To toggle between Table and Spectrum view press CTRL+F3."

GUI User Interactions

Clear

Deactivate a software feature by positioning themouse cursor over a selected
check box and pressing the left mouse button.
Example: "Clear the Curve Smoothing option."

Click

Position themouse cursor over a GUI element and press the left mouse button to
start an action in the software.
Example: "ClickOK."

Click and drag

Position themouse cursor in a window and press the left mouse button. Hold the left
mouse button down andmove the cursor to select a (usually rectangular) area.
Example: "Zoom in on peaks of interest by clicking and dragging in the Spectrum
window."

Double-click

Position themouse cursor over a GUI element and press the left mouse button
twice in quick succession to start an action in the software.
Example: "Double-click the Sample icon."
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Drag and drop

Position themouse cursor over a GUI element and press the left mouse button.
Hold the left mouse button down andmove the selected element to a new location.
Example: "Drag and drop the tab into the desired tab group."

Select

Navigate to a desiredmenu command.
Example: "Select File > Zip > Zip Project…"
Position themouse cursor over a GUI element (e.g. a table entry) and press the left
mouse button to highlight it.
Example: "Select the desired file in the list and click Export."
Activate a software feature by positioning themouse cursor over an empty check
box and pressing the left mouse button.
Example: "Select theCurve Smoothing option."

Right-click

Position themouse cursor over a GUI element and press the right mouse button to
open amenu for the selected element.
Example: "Right-click in the SpectrumView window".
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1 Introduction

flexAnalysis 3.4 is the post processing software for spectra acquired with the Bruker time-
of-flight mass spectrometers of the flex series. The program runs under XP (SP3), 32 bit,
and Windows 7 (64 bit) operating systems. Windows NT, Windows 2000, and Windows
Vista are not supported.

Before installing flexAnalysis 3.4 for the first time, the programMicrosoft .NET Framework
-3.5 must be installed, because flexAnalysis is based on features, which Microsoft .NET
Framework 3.5 provides. This program is also part of the Compass installation DVD (see
Figure 1-1). 

Figure 1-1 Compass DVD

flexAnalysis uses standard Microsoft Windows conventions to operate with windows,
menus, dialog boxes, and the mouse. The operator is supposed to be familiar with the
basic operation of the computer and with Microsoft Windows software.  Some general
instructions are given here, but if additional support is necessary regarding the basic use of
a computer, please review its accompanying documentation.

flexAnalysis 3.4 is able to operate in combination with the Bruker Compass Security Pack
2.0. This program can be installed prior to flexAnalysis or after it.   

Main features of the Bruker Compass Security Pack are a user management, electronic
signatures and audit trailing. This is different to the user management of the operating
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system! The Bruker User Management is a tool that allows you to manage the access to
Bruker applications and assign individual rights to users.  Depending on these rights the
access of a user to features of Bruker applications ismore or less restricted. 

On saving data files, the operator can electronically sign them, if he has got this specific
right. Electronic signatures consist of the operator ID and his password (see Figure 2-10). 

Audit trails are useful to trace back the operations of a user hemade in a specificmoment. 

The Bruker Compass Security Pack and user management are described in a separate
manual.

flexAnalysis 3.4 provides the following key features:

l Multiple spectrum display for convenient spectra comparison and analysis. 

l Highly sophisticated algorithms for authentic automated and interactive peak
detection (SNAP, Centroid, and Sum peak finder).

l Highly sophisticated algorithms for spectrum processing (smoothing, baseline
subtraction).

l Highly sophisticated algorithms for automated and interactive recalibration of
spectra (linear, quadratic, cubic enhanced, statistical and iCal support).

l MS/MS support: Presentation and processing of LIFT spectra aswell as generation
of FAST spectra.

l Annotation

l Spectrum and graphic export.

l Report designer for creating user defined analysis reports and specific report
layouts.

l Integrated Sax Basic Development Environment for the design of flexAnalysis
methods and scripts. Sax Basic is Visual Basic for applications™ compatible.

l Proteineer Support: Integrated data exchange with BioTools and ProteinScape
program packages. 

l Data processed in flexAnalysis 3.4 can be delivered in form of spectra and peak lists
to further interactive data processing software packages such as GenoTools (SNP
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[Single Nucleotide Polymorphisms], genotyping analysis) or Polytools (monomer
determination, averagemolecular weight).

1.1 Getting Started

In case of installing flexAnalysis 3.4 as a standalone version, it can be installed from the
Compass 1.4 installation DVD (see Figure 1-1).

1.2 Installing flexAnalysis 3.4

Please refer to the separate installation instructions on the Compass installation DVD, or
contact Bruker via e-mail (see "Contact" on page 3).

1.3 Removing flexAnalysis 3.4

1. Start your Windows application.

2. SelectStart > Settings > Control Panel.

3. Double-clickAdd/Remove Programs.

4. From the applications list, select Bruker Daltonics flexAnalysis 3.4.

5. ClickAdd/Remove.

6. Follow the Install ShieldWizard instructions to remove flexAnalysis 3.4 from your
system.

1.4 Licensing flexAnalysis 3.4

A 60-day-license is installed together with the first installation of flexAnalysis 3.4. After it
has expired a dialog appears (see Figure 1-2).

flexAnalysis 3.4 User Manual Revision 1 Page 15 of 176



1 Introduction Bruker Daltonik GmbH

Figure 1-2 FA is not yet licensed

After applying the OK button the Bruker Daltonics LicenseManager (see Figure 1-3)
opens. The Compass license key comes in a separate envelope with the software.

Figure 1-3 The Bruker Daltonics LicenseManager.

Click Edit and, if necessary, confirm some dialogs or enter the requested administrator
password. Afterwards enter the key in the edit fieldNew License Key and press theAdd
button.
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Figure 1-4 Typing a new license key into the Bruker Daltonics LicenseManager

If the Bruker Compass Security Pack is installed licenses can only be added or removed
by users who have the corresponding right. In this case a dialog appears where users can
enter the password (see Figure 1-5).

Figure 1-5 Enter the password to add or delete a license key

A license key can be removed with the Delete button. Before deletion, a warning appears
(see Figure 1-6).
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Figure 1-6 Warning before deleting a license

The Bruker Daltonics LicenseManager dialog box can also be launched from the
Compassmenuwith the License command (see section 2.4.13.1). 

1.5 Starting and Closing flexAnalysis 3.4

Starting flexAnalysis 3.4

flexAnalysis 3.4 can be started via the Windows Start menu.  During installation of the
Bruker Daltonics Applications package, a Bruker Daltonics folder was automatically
created in theStartmenu'sPrograms folder, which contains the applications delivered by
Bruker Daltonik.  Select the flexAnalysis entry from this folder in order to start flexAnalysis
3.4. A second way to launch flexAnalysis 3.4 is double clicking the corresponding icon on

theWindows desktop .

Closing flexAnalysis 3.4

This procedure closes flexAnalysis 3.4. On closing, the current user interface settings are
automatically stored. 

In order to exit flexAnalysis 3.4 click the application's Close button or from the File
menu selectExit, or press ALT+F4.

If required, answer the appearing confirmation request to save the current processing
state of amodified analysis.
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2 Graphical User Interface (GUI)

Figure 2-1 The flexAnalysis Graphical User Interface

TheGUI is composed of the following items:

l Title bar (see section 2.1)

l Menu bar (see section 2.4)

l Toolbar (see section 2.2)

l Analysis List window (see section 2.5.1)

l MassSpectrumwindow (see section 2.5.2)

l Mass List window (see section 2.5.3)

l Sequence List window (see section 2.5.4)
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l SmartFormula List Window (see section 2.5.5)

l Status bar (see section 2.3)

2.1 Title Bar

The title bar (see Figure 2-2) contains the name of the application, and, if one analysis is
selected, the title of the analysis file.  If a title is not set in the flexAnalysis Properties
dialog, the first two comments, (see Figure 2-14) are displayed in the title bar. The left end
of the title bar contains the application'sControl menu button. The right end contains the
familiar WindowsMinimize,Maximize, andClose buttons.

Figure 2-2 Title bar of flexAnalysis 3.4

2.2 Toolbar

Figure 2-3 flexAnalysis toolbar

Feature buttons have been given for commands that are regularly used.  These buttons
are organized into several groups and can be found also in themenus. 

2.3 Status Bar

The status bar (see Figure 2-4) is located at the bottom of the GUI. In themiddle it contains
the sample name of the currently active spectrum for a saved spectrum (automsms\0_
I14\) or the name of the loaded processing method (PMF [read-only]) as long as the
spectrum is not saved. 

Figure 2-4 Examples of a Status Bar for a saved and un-saved spectrum
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The second field displays the parent mass in case of fragment spectra (not shown here).

The third field shows the selection mode (Annotate), which is currently active. The next
field shows the name of the current user followed by two fields that show the current
mouse pointer position in theMass Spectrumwindow.

2.4 Menu Bar

Themenu bar (see Figure 2-5) consists of 13 drop-downmenus. Thesemenus contain all
the features to operate flexAnalysis.  Open amenuwith the left mouse button, for example
the Filemenu as shown in the following section.

Most of the features that are available in these menus can be found also as buttons in the
button bar, or as entries in the shortcut menus of the threemain flexAnalysis windows.

Figure 2-5 Content of the flexAnalysis menu bar
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2.4.1 File Menu

Figure 2-6 Contents of the File menu

The Filemenu is composed of commands to open, close and save data, handle the user
management.
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Table 2-1 Features of the File menu

Feature
button

File menu
commands Shortcut Description

Open CTRL+O Opens theOpen multiple spectra dialog.

Open single
Analysis

CTRL+SHIFT+O Opens one selected analysis.

Close CTRL+F4 Closes the selected analysis or analyses.

Close All Closes all analyses.

Load Loads an analysis in the tree view.

Unload Unloads an analysis from the tree view

Save CTRL+S Saves results of the selected analyses
including themethod.

Save As Saves results of the selected analyses
including themethod to a user specific
location.

Save All SHIFT+CTRL+S Saves results andmethod of all open
analyses.

Sign
Electronic
Record

Signs an electronic record.

Show
Signatures

Shows the signature of a signed file.

Export Offers various possibilities to export data.

Properties ALT+ENTER Displays analysis and mass spectrum
properties (variable table).

Exit ALT+F4 Closes flexAnalysis.
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2.4.1.1 Open

The Open command opens the Spectrum Browser dialog that allows selecting and
loading spectra depending on several filter criteria (it is not necessary to select the fid
file to load a spectrum).

flexAnalysis reads two kinds of spectra formats:

1. The Xmass file format. In this file format raw data are stored in a file called fid. Data
already processed from flexAnalysis are stored in a file called 1r. If the analysis was
not processed before, the raw data file fid is loaded, otherwise the result spectrum
of the process (1r). All this happens automatically, the user can only select the fid.

2. The Container file format. This file format is written only during AutoXecute runs that
are started from WARP-LC or from flexImaging. In the container data format, all data
from an AutoXecute run with the same sample name are saved in a single directory
with a .d extension that contains only a few files. Bruker software never prompts for
files within the directory, it only requests the .d directory.

When spectra are loaded and processed in flexAnalysis no difference is seen between
XMass and Container spectra.
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Figure 2-7 Spectrum Browser

l Browse: Select the folder from the hard drive with the data of interest. 

l Root: Shows the selected path and folder. 

l Filter Spectra: Select checkboxes to filter the data type you want to open. If the
data structures correspond to the flexControl saving convention, a tree structure is
displayed on the left side of the dialog (see Figure 2-7).  If the saving convention is
not applied select the checkboxUnknown to let the data appear.

l From – To: Time filter to search for spectra.

l Spectrum Properties: Shows the properties of a selected spectrum. 
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l Spectra selected: Displays the number of selected spectra. Applying the button
Clear Selection sets it to 0.

l Spectra: Shows the number of selected spectra in comparison to the total number
of spectra found in the chosen root directory. 

l Open: Loads all selected spectra in flexAnalysis and closes theSpectrum
Browser. 

l Cancel: Closes the SpectrumBrowser without loading a file.

l Select All: Selects all folders and subfolders of the chosen root directory. 

l Clear Selection: Undoes theSelect All function.

l Load all selected spectra: Loads and opens the spectra in flexAnalysis.

l : Updates theSelected spectra view

2.4.1.2 Open Single Analysis

In contrast to theOpen commandwhere one or more spectra can be opened at the same
time theOpen Single Analysis command opens only one spectrum. Here it is necessary
to browse to the fid file (in the spectrum tree) and select it.

Additionally to the spectrum a method is loaded automatically. A flexAnalysis method
determines how to process an analysis. The method that is loaded together with the
analysis is either specified by the analysis itself (due tomethod assignment during the save
process in flexControl) or, if no specification has been done in flexControl or AutoXecute,
by the Default Method selection (see section 2.4.7.8).

If a spectrum has never been saved with flexAnalysis before, the method script (part of the
method) is executed. 

The drag and dropmechanism to open spectra works as follows:

1. Start flexAnalysis.

2. Start theWindowsExplorer.

3. Navigate for the folder that contains the spectrum/spectra you want to open.

4. Drag and drop the selected folder on the display windows of flexAnalysis.
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In case of loading FAST spectra that have been acquired with flexControl 1.x, and
therefore have no valid calibration, a dialog appears to load thematching calibration file
(*.psd) (see Figure 2-8). 

Figure 2-8 Searching for FAST calibration files

2.4.1.3 Close

Spectra are closed with theClose command, the corresponding icon of the toolbar, or
the short cut (CTRL+F4).

The feature closes only those analyses that are marked in the Analysis List Window.  In
case the analyses are currently not saved a confirmation dialog appears and asks for
saving before closing.

2.4.1.4 Close All

The Close All command closes all open analyses. In case any spectrum is currently not
saved a confirmation dialog appears and asks for saving before closing.

2.4.1.5 Load and Unload

The Load command loads the data of an analysis that is open but not yet loaded (see
Figure 2-9) in the flexAnalysis tree view from the hard drive in the memory. The Unload
command unloads them again.

Alternatively you can click with themouse in the corresponding checkboxes in the Analysis
List Window to load the analysis.
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Figure 2-9 Loaded and unloaded spectra in the tree view

If you want to open a large number of spectra in the flexAnalysis tree view without loading
them all at once, you may open them with the Spectrum Browser Open command, (see
Figure 2-7). In this dialog you will find the checkbox Load all selected spectra at the
bottom. For loading a lot of spectra the checkbox should not be activated. Otherwise, if you
only want to load few spectra at once, activate this box.

If you want to change the order of the loaded (and unloaded) spectra in the tree view, just
move one spectrumwith pressed left mouse key to the desired place.

2.4.1.6 Save

The Save command, the corresponding icon of the toolbar, and the short cut
(CTRL+S) store the current processing state of the selected analysis including the
processingmethod.  

TheSave command can be applied to several selected analyses at a time after these have
been marked in the tree view with the <Shift> or <Ctrl> - keys of the keyboard thus
followingWindows conventions. 
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2.4.1.7 Save As

TheSave As command is used to save the selected analyses including the method with a
new name and to a new location.

2.4.1.8 Save All

TheSave All command or the short cut (Shift + CTRL+S) stores the result spectra of all
opened analyses at once, including the processingmethods.

2.4.1.9 Sign Electronic Record

TheSign Electronic Record command is used to sign spectra electronically when they
have been processed. It is only available if additionally the Bruker Compass Security Pack
is installed. After a spectrum is signed it is write-protected.

To sign a spectrum it is necessary that the user who wants to sign has the
UserManagement given right to sign. This is checked during the sign process when the
user fills in his Operator name and password (see Figure 2-10). The field Meaningmay be
used for comments.

Figure 2-10 Sign Electronic Record dialog

2.4.1.10 Show Signatures

The Show Signatures command is also only available if additionally the Bruker
UserManagement is installed and becomes active if a signed file is marked in the tree
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view.  It opens theView Signatures dialog.

Figure 2-11 View Signatures dialog

l Date: This column shows the date and your local time.  The value most right in this
example +1:00 corresponds to GMT +/- your time zone.

l Signed by : This column contains the name of the user, who has signed the
spectrum. 

l Meaning: This column contains the comment that has been entered during signing.

l Valid: This column contains remarks about the current validity status of data.  In this
example the validity is not yet checked. To do so apply the “Check Validity” button. 
The attribute unknownwill change to valid.

A double click on a signature in the list opens a dialog that shows if the state of all checked
files is ok. 

Figure 2-12 List of files, three file are mismatched
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2.4.1.11 Export

TheExport command is used to export spectra and graphics into other applications, or a
peak list to Excel. To retain versatility spectra are exported in the common ASCII-file
format, whereas graphics are exported in the common emf format (WindowsEnhanced
Metafile).

On selecting the Export\Mass Spectrum command theExport Mass Spectrum dialog
appears to save a 2-column tabular with pairs of data points (m/z / intensity).  Type a file
name into the field File name and press the Save button. flexAnalysis creates the
corresponding file. With this macro only one mass spectrum can be exported. With the
batch processingmacro and a suitable flexAnalysismethodmore than onemass spectrum
can be exported at the same time. The method does not belong to the standard
installation, please contact maldi.sw.support@bdal.de.

On selecting the Export\Graphic command the Export Graphic dialog appears to
specify the file name and location to export a graphic.

The Export\ Raw Spectrum as mzXML option offers the export of the unprocessed
spectrum in the mzXML format. A dialog appears to specify the file name and location. If
you want to export more than one spectrum at a time into the mzXML format, the Bruker
programCompassXport will be a good choice. It is available for download from our
homepage.

TheExport\Mass List to Excel command exports the peak list to Excel (see Figure 2-
13). Thismacro exports all available peak list parameter. If you want to export only some of
them please contact maldi.sw.support@bdal.de.

Figure 2-13 Mass list exported to Excel
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2.4.1.12 Properties

The Properties dialog is opened by selecting File > Properties , clicking the

corresponding icon of the toolbar or double-clicking the first line of an anlysis in the
tree view, or pressing ALT+ENTER.

TheProperties dialog consists of theGeneral page, theMass Spectrum page, and the
Calibration page. A fourth possibility to open the Properties dialog is from the shortcut
menu of a spectrum in the tree view.

All three tabs are displayed, if the operator has previously selected only one spectrum in
the Analysis List window. In case of multiple spectra selection only theGeneral tab
appears.

Figure 2-14 Contents of the General tab.

The General tab (see Figure 2-14) is used to display general information regarding the
selected analysis such as file name, sample, mass spectrometer, title, and comments
specific to the current analysis. Changes of title and comments can be performed and
accepted by pressingApply. 
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Figure 2-15 Contents of the Mass Spectrum tab

TheMass Spectrum tab (see Figure 2-15) is not editable. It displays groups of acquisition
and processing parameters of the current analysis. The group arrangement and the
distribution of the parameters have been done according to flexControl. The flexAnalysis
parameter groups for example have the same names as the tabs in flexControl where the
acquisition parameter can be adjusted.
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Figure 2-16 Contents of the Calibration tab

The Calibration tab (see Figure 2-16) can be used to verify the calibration.  Additionally
some general information about the calibration are shown: calibration mode, source
spectrum in case of an external calibration, and so on).

flexControl and flexAnalysis 3.4 store the calibration state along with each spectrum. The
calibration state not only denotes the time stamp of a calibration, but the complete
calibration information including assigned peaks. This information is visualized in the
flexAnalysis spectrum properties. The information is updated whenever a spectrum is
(re)calibrated in flexAnalysis. This means that without a (re)calibration having been
performed in flexAnalysis, the shown calibration date is the calibration date of the
flexControl method. The calibration information shown in the dialog can be saved as text
file with the buttonSave.

2.4.1.13 Exit

TheExit command and the short cut (ALT+F4) are used to close flexAnalysis.  However
before closing a dialogmay open and ask you to savemodified analyses. 
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2.4.2 Edit Menu

Figure 2-17 Contents of the Edit menu

The Edit menu contains commands to work with the appearance of spectra in the three
main windows. 
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Table 2-2 Features of the Edit menu

Feature
button

Edit menu
commands Shortcut Description

Copy CTRL+C Copies the selection (context dependent) and
puts it on the Clipboard.

Paste CTRL+V Inserts the contents of the clipboard.

Paste
Special

Pastes methods, method parameters or
method scripts.

Delete DELETE Deletes the selectedmass spectrum.

Select All CTRL+A Selects all open analyses including all mass
spectra.

Select None CTRL+D Deselects all currently selected analyses,
and/or mass spectra.

View
Analysis

CTRL+INSERT Hides/Shows the selected analysis.

View
Spectrum

INSERT Hides/Shows the selected spectrum (except
raw data).

Set Color Opens a palette of colors for manual allocation
of a color to a spectrum.

Default
Color

Resets previous color assignments.

Set
Selection
Range

Selects amass range in theMass Spectrum
Window.

Clear
Selection

Clears the current mass range selection in the
active data window.

Box
Selection

Toggles Mass Spectrum Window between
Range Selection and Box Selectionmodes.
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2.4.2.1 Copy

The Copy command, the corresponding icon of the toolbar, and the short cut
(CTRL+C) are used to copy context dependent data into the clipboard. Afterwards the
copied information may be pasted to other spectra or other applications, like Microsoft
Office programs. According to the active flexAnalysis window the user can use Copy in
the

l Analysis List Window (tree view), to copy the method (parameter and script) from
the selected spectrum.

l Mass Spectrum Window, to copy the currently shown graphic, independent of the
spectrum that is possibly selected in the tree view.

l Mass List Window, to copy the currentlymarked line(s) of the peak list.

2.4.2.2 Paste

The Paste command, the corresponding icon of the toolbar, and the short cut
(CTRL+V) are only available for the Analysis List Window (tree view). With this button the
just copied method (parameter and script) can be pasted to one or more other analyses.
This feature is helpful if you have adjusted and saved a new method and want to apply it to
several other spectra.

2.4.2.3 Paste Special

ThePaste Special command is also only available for the Analysis List View and applies
themethod, which has been copied before. Since a method consists of parameters and a
script the operator may want to transfer only parameters or only the script to other
analyses. In this case thePaste Special command has to be used.

To test this feature, load three spectra in flexAnalysis. For the first one change some
spectrum parameter (see section 2.4.7.5) and edit the script (see section 2.4.7.7). Mark
the first spectrum in the tree view and choose Copy. Now mark the other spectra (CTRL
key) and select Paste or Paste Special to paste the method content. Check the new
settings for the two spectra in the parameter and the script editor.
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Figure 2-18 Paste Special dialog

2.4.2.4 Delete

The Delete command, the corresponding icon of the toolbar, and the short cut
(DELETE) are context dependent.

In the tree view it is used to delete one or more processing steps (corresponds to the
Undo All Processing command) but it does not delete the raw data file (no feature exists
in the flex programs that can delete the raw data).

In the Mass List Window the Delete command is used to delete the selected lines of the
peak list.

The command is not available for theMass SpectrumWindow.

2.4.2.5 Select All

The Select All command and the short cut (CTRL+A) are used to select the entire
content of the active window, which is the Analysis List, the Mass Spectrum, or the Mass
List. 

2.4.2.6 Select None

The Select None command and the short cut (CTRL+D) refer to the active window and
deselect everything that was previously selected. 
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2.4.2.7 View Analysis

TheView Analysis command, the short cut (CTRL+Ins), and disabling the root checkbox
in the tree view are used to display or remove one or more selected analyses from the
Mass SpectrumDisplay. 

Figure 2-19 Example for an analysis not displayed in the Mass Spectrum Window

The analysis, which is not displayed in the SpectrumWindow remains in the Analysis List
Window, however the corresponding root checkbox is cleared (see Figure 2-19). 

2.4.2.8 View Spectrum

TheView Spectrum command and the short cut (INSERT) are used to display or hide a
selected spectrum or selected spectra in theMass SpectrumWindow.

Pressing the INSERT key a second time or selecting the related checkbox restores the
display.

2.4.2.9 Set Color 

TheSet Color command opens a palette of colors (see Figure 2-20). 

Figure 2-20 Palette of provided colors

This command is used to change the color of one or more selected mass spectra.  If only
one spectrum is selected a white frame indicates the current color used for the selected
mass spectrum. To change the color, simply click the desired color box.
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2.4.2.10 Default Color

In flexAnalysis color assignments are performed according to a color hierarchy.  Each
color in this hierarchy has a unique value.  Colors with higher values will be used prior to
colors with lower values.  The Default Color command assigns colors to the selected
spectra, which are currently unused and have the highest scores in the color hierarchy. 

2.4.2.11 Set Selection Range

TheSet Selection Range command is used to select amass range of the currently active
spectrumwithin theMass SpectrumWindow, for example to run a peak picking process in
this specific range. Additionally, an intensity range can be defined, when the button
Range/box selection type is pressed.

In the dialog box minimal and maximal mass and intensity values can be entered to define
the ranges. If only the mass range is requested, choose “Range selection”, to disable the
intensity range.

Figure 2-21 Range Selection dialog box

2.4.2.12 Clear Selection

This command is used to clear a selected range in theMass SpectrumWindow. 

2.4.2.13 Box Selection

This function determines the selection mode.  If the box selection is switched on, both the
mass range and the intensity range are selected.  If the box is switched off only the mass
range is selected. 
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2.4.3 Mass List Menu

Figure 2-22 Contents of the Mass List menu

The Mass List menu (see Figure 2-22) is composed of commands to work with mass
lists. 
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Table 2-3 Features of the Mass List menu

Feature
button

Mass List
menu
commands

Shortcut Description

Find F5 Automatically creates a mass list for the
selected spectrum (spectra).

Edit (De)Activates the Edit Mass List mode to
edit themass list of the selected spectrum. 

Edit Direct CTRL+ALT Adds a (m/z-intensity)-pair to the peak list.

Clear SHIFT+ F5 Clears themass list of the selected
spectrum.

MS/MS List Opens a list with masses that have been
selected from the MS peak list for manual
or automatic LIFTmeasurement in
flexControl.

Edit Mass
Control List

Opens theMassControl List Editor

Identify
Background
Peaks

Identifies background peaks on the basis of
aMassControl List that has to be selected
here.

Remove
Background
Peaks

Removes the previously identified
background peaks from the peak list.

Distances in
Mass List(s)

Macro to compare spectra.

2.4.3.1 Find

The Find command, the corresponding icon of the toolbar, and the short cut (F5) are
used to automatically generate a peak list for one or more selected spectra
simultaneously. 
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Peak picking is performed according to the parameter settings of the current method (see
section 2.4.7.5.1). The result is stored in the peak list and the mass spectrum is displayed
with the detectedmass peak labels. 

Only one peak list can be displayed at a time. However, more than one list can be
(re)calculated at once, by selecting the corresponding spectra with the mouse pointer in
the Analysis List Window and simultaneously pressed CTRL key of the key board.  Then
activate the Find command for a peak finding in all the selected spectra. 

2.4.3.2 Edit

It might become necessary to edit the peak list manually, because too many or too few
peakswere detected during the automatic peak find procedure. 

TheEdit command and the corresponding icon of the toolbar are used for interactively
adding or removing peaks, according to the respective peak detection algorithm.

This command displays the Edit Mass List pointers or , if the mouse pointer is

positioned in the Mass Spectrum Window.  The Add pointer is displayed when the
mouse is placed near to a peak that currently has no annotation, whereas the delete

pointer is placed next to an already detected peak in the spectrum.

If the new peak can be found using the Mass List Edit Method Parameter settings, the
results are added to the peak list and a label appears in the display. To remove a peak
from the peak list place the Delete pointer to the peak and press the left mouse button.

The Edit mode becomes also active when themouse is inside theMass SpectrumWindow
and the CTRL key is simultaneously pressed.

2.4.3.3 Edit Direct

The Edit Direct command, the corresponding button and the short cut (CTRL+Alt)
are used to add an annotationmanually. This pair of (m/z / intensity) data can be located at
any position in the spectrum; the x-position is independent of a data point!

If this mode is activated, the mouse in the display will get a crosshair, to better see the
mass and intensity values. Additionally you will get a ToolTip, which shows these
information and the spectrum name (see Figure 2-23). This feature will be deactivated
right after you have added an annotationmanually.
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Figure 2-23 Edit Mass List directly

An entry is added to the peak list, but only the columns forMass, Intensity andRelative
Intensity are filled. Because the peak annotation has not been created with a peak
detection algorithm that would also calculate the other parameters, the coordinates from
them/z and intensity scales are used.

2.4.3.4 Clear

The Clear command, the corresponding button of the toolbar, and the short cut
(SHIFT+F5) are used to clear the current mass list of the selected spectrum or spectra.

Select the spectrum/spectra in the Analysis List Window (if necessary with simultaneously

pressed CTRL key) whose mass list(s) shall be cleared, click , or from the Mass List
menu select Clear.

2.4.3.5 MS/MS List

TheMS/MS List command works in connection with the Add to MS/MS List command
that is available in the Mass List shortcut menu (see section 2.6.3). Masses from a MS
peak list that have been added to the MS/MS List can be sent to flexControl for manual (

), or automatic ( ) LIFT measurement (certainly
also “Runmethod on current” can be used in flexControl).
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To add masses from the peak list to the MS/MS list, right-click on the desired mass and
choose Add Mass to MS/MS List. This can be done for several peaks from the same
spectrum and for several spectra from the same target.

After masses have been added to the list, it can be opened with theMS/MS List command
that then shows a dialog (see Figure 2-24). Peak masses and spot numbers are listed.
The whole list can be cleared with the button; single masses can be removed
with the button.

The button is used to send the whole list to the LIFT  tab in
flexControl. It is not necessary to have flexControl opened before. The masses of this list
are then shown as selection list, so there is no need to type in themassesmanually one by
one.

Figure 2-24 MS/MS List with masses selected for LIFT measurement

To be able to use the button it is necessary that theMS spectra have
been acquired either during an AutoXecute run, or manually with usage of the check box
Add to run that is available in the Save As dialog in flexControl. Only these preconditions
provide an AutoXecute run where the selected parent masses can be added to.
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The button is unavailable when nomatching sequence can be found.
It is not possible to create a sequence afterwards.

With this feature it is possible to do automatic LIFT measurement with masses that have
been selectedmanually from a correspondingMS spectrum (in the AutoXecute sequence
noMSmeasurement has to be specified).

The AutoXecute method and the flexAnalysis method, which are necessary for automatic
MS/MS acquisition and post processing, are added automatically to the sequence due to
settings performed in the flexConfigurator. For more information on the method
assignment please see the flexControl user manual.

It is possible to add peaks from different spectra to the list. These spectra may have been
acquired on different sample spots (see Figure 2-24). The only restriction is that theymust
have been acquired on the same target, which is identified by the so called carrier ID
shown in the lower right corner of the flexControl GUI (e.g. T_0209519_0004835_36).
Otherwise a message appears during spectra selection (see Figure 2- 25) . More
information about this feature are given in the quickstart document Quickstart_
PrecursorSelection.pdf.

TheSave As button saves theMS/MS list to a .csv file for use by other applications (for
instance, Microsoft Excel).

Figure 2-25 Information concerning different targets 

2.4.3.6 Edit Mass Control List…

Opens theMass Control List Editor, where you can define calibrant and/or background
masses.
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Figure 2-26 Mass Control List Editor

Mass Control List is a general term for lists that can be used as calibrant lists as well as
background lists, by activating the respective check box. flexControl and flexAnalysis use
the same lists, and, depending on the context from where a list is opened, either the
column Calibrant is shown ( Calibration dialogs), or the column Background
(AutoXecute Method Editor), nevertheless the invisible information is still available.
More details regarding the Mass Control Lists are given in the quickstart document
Quickstart_MassControlLists.pdf.

2.4.3.7 Identify Background Peaks

The Identify Background Peaks command is used to identify background peaks in a
spectrum on the basis of aMassControl Lists (*.mcl) that has to be selected with this
command.

To create or modify an existing background list, it has to be opened with theMass Control
List Editor (see section 2.4.3.6). Onlymasses that aremarked as backgrounds in this list
(see Figure 2-26) can be used to identify background masses in a spectrum. Masses can
bemarked as calibrants and/or as backgrounds. The Tolerance value is valid for both.

After a Background list has been applied to a spectrum, all peaks are marked with true or
false in the columnBk.Peak that can be selected as additionally shown column in the peak
list (see Figure 2-27).
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The column Bk.Peak has been added to the Mass List Layout (Mass List Layout tab in
theMethod Editor (see section 2.4.7.5.4)).

Peaks, which are identified as background in the spectrum, become colored in the
spectrum display, according to the chosenBackground Peak Label color (see section
2.4.11.7.6). Additionally the display priority changes: if the label of a background peak
overlapswith a label of a normal peak, the background label is omitted. But this does not
change the currently available peak list! The Background filter feature might be useful for
further processing, e.g. database searches in BioTools.

Figure 2-27 Assignment of background peaks (true) in the column Bk.Peak

If, during an automatic run the background peak detection has been activated in the
AutoXecutemethod, the information about which MassControlList is used is transferred to
flexAnalysis. The name of the Background list is shown in theMass Spectrum
Properties dialog (see Figure 2-28).

Figure 2-28 Background list information in the spectrum properties

Page 48 of 176 flexAnalysis 3.4 User Manual Revision 1



Bruker Daltonik GmbH 2 Graphical User Interface (GUI)

2.4.3.8 Remove Background Peaks

The macro Remove Background Peaks is used to remove previously identified
background peaks from the mass list of the currently active spectrum. To save the new
peak list save the analysis! It is not possible, to remove background peaks without having
identified them before!

To remove background masses automatically during an AutoXecute run, a special
flexAnalysismethod is necessary. Please contact theMALDI Software Support
(maldi.sw.support@bdal.de) to get more information about this or see the pdf- file
Quickstart_Annotate_extern_cal.pdf that is available on the installation DVD
in the folderManual.

2.4.3.9 Distance in Mass List(s)

The macro Distance in Mass List(s) is used to search for specified fixed distances
between peaks of one spectrum or of two spectra. It may be used for instance to search for
salt adducts in MS spectra, amino acids in MS/MS spectra, or compare two ISD-spectra
(Ion Source Decay) of the same sample but with different matrices in order to inspect
differences inm/z of the fragment series. 

The spectrum or the spectra to be inspected have to be selected in the Analysis List
Window. At most two spectra can be selected. In case of more selected spectra themacro
will be disabled!

If not yet available, a peak list from any of the two selected spectra has to be created. 
Otherwise amessage appears (see Figure 2-29).

Figure 2-29 No peak list available

TheDistance in Mass List(s)macro opens a dialog (see Figure 2-30). 
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Figure 2-30 AutoDistance dialog

l Distance: Mass distance value to be searched for.

l Tolerance: The search tolerance.  It can be specified in Da or ppm.

l Spectrum/First Spectrum: The drop down list contains up to two spectra.  In case
of two define the one that is used at first.

l Calculate: Starts to calculate and search for the selected distance. 

l Result: List containing the calculations of flexAnalysis.

l Save As: This button opens the dialog to save the result as a CSV-file that different
applications, e.g., Excel can easily import (see Figure 2-31). 
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Figure 2-31 Example of a Distance-in-mass-list result

2.4.4 Process Menu

Figure 2-32 Content of the Process menu

TheProcessmenu (see Figure 2-32) is composed of various commands to process
spectra.
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Table 2-4 Features of the Process menu

Feature
button Process menu commands Description

Smooth Mass Spectrum Smooth selected spectra.

Subtract Mass Spectrum
Baseline

Subtract baseline from selected
spectra.

Undo All Processing Reverses all processing.

Batch Process Processes data in batchmode.

Process spectra Easyway of reprocessing spectra.

2.4.4.1 Smooth Mass Spectrum

The Smooth Mass Spectrum command and the corresponding icon of the toolbar
are used to smooth the selected mass spectrum. The method parameter settings of the
analysis are used for the smoothing operations (see Figure 2-69). 

2.4.4.2 Subtract Mass Spectrum Baseline

The Subtract Mass Spectrum Baseline command and the corresponding icon of
the toolbar are used to perform a baseline subtraction for the selected spectrum or
spectra.  The method parameter settings of the analysis are used for the baseline
subtraction operation (see Figure 2-70).

2.4.4.3 Undo All Processing

The Undo All Processing command is used to return to the starting point before any
processing took place.  The raw data file (‘fid’- file) is loaded and displayed in the Mass
Spectrum Window. Note that Undo All Processing does not cancel the possibly done
calibration. If you want to apply additionally the original calibration constants use the
commandApply raw calibration (see section 2.4.5.4).

2.4.4.4 Batch Process

The Batch Process macro is used to (re-)process spectra. The Batch Process dialog
sends the spectra to the ProcessQueuer, which starts several flexAnalysis processes in
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order to spread the spectra over the different invisible processes.

The maximum number of started flexAnalysis processes depends on your computer
hardware.
This approach saves processing time. Additionally it is now possible to configure the
number of used processes in theOptions part of theBatch Process dialog. TheBatch
Process command opens a dialog (see Figure 2-33).

Figure 2-33 Example of a Batch Process dialog
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l From: displayswhether the shown spectra have been loaded with the button
Folder or the button AutoX Run . This is important because only with loading
spectra with the button AutoX Run it is possible to use different flexAnalysis
methods, which is amajor requirement for the recalibration of MS spectra.

l Folder : Select data file(s) for (re)processing with the Open Multiple Spectra
dialog. The selected data path will be shown on top. The complete path(s) are
displayed in the list. If spectra are loaded with the Folder button, you have to select
amethod with one of theBrowse buttons below and start the batch processing
afterwards.

l AutoX Run: Alternatively open an AutoXecute run to load the data that have been
acquired with this run.

Note flexAnalysis methods must be assigned via the RunEditor sequence, it is
shown with the information from AutoXecute that appears after loading
the run.When nomethods are selected in the AutoXecute run, i.e. the table
column(s) FA MS and/or FA MS/MS are empty (because the FA methods
have been selected in the AutoXecute methods) the spectra are not loaded
but amessage is displayed (see Figure 2-34).

Figure 2-34 No flexAnalysis method specified message

It is of course possible to add or change the methods selection in the RunEditor
sequence even if the data are already measured and have been processed once.
To do so just reload the sequence via flexControl in the AutoXecute Run Editor,
add or change the flexAnalysis methods, and save the run, maybe with a new
name (e.g. xxx_for_FA_postprocessing.xml) to have the original run still
as backup. If the flexAnalysis methods are available in the run the spectra will be
loaded in the flexAnalysis Batch Process dialog without problems. Please
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remember to use a so-called calibration template when you set up an AutoXecute
run that contains calibrant spots aswell as sample spots.

l Delete selected: you can mark one spectrum in the list with the left mouse button.
To select several spectra hold the CTRL or SHIFT key pressed. Click on theDelete
selected button if you want to delete themarked spectra from the batch processing
list.

l Clear All: The list of the prior loaded spectra can be deleted completely with the
Clear All button.

l Browse: Each Browse button opens a dialog to select a method for the respective
spectrum type. Thismethod will be used for the batch process.

l No. of FA Processes: Enter the number of processes you want to use for the
batch process. The maximum number of available processes is automatically
shownwith the start of theBatch Process dialog.

l Mascot Search: If spectra are loaded that have been sent during an AutoXecute
run to BioTools for a Mascot search before, you may decide here if they should be
sent to Mascot again after reprocessing in flexAnalysis, or not. If you only want to
reprocess the spectra, deactivate this box.

l Start: Starts a batch process (see Figure 2-35). After a few seconds the estimated
time is shown in the lower right corner. The Start button changes to Stop. This
means if you click again on the button, the batch processing is stopped.

The Start button is unavailable when an AutoXecute run has been started before in
flexControl, and the spectra processing that is triggered from this run is still in progress.

The other way round,that is when a batch process has been started in flexAnalysis, it is not
possible to start an AutoXecute run, because only one program at a time is allowed to
access the flexAnalysis processes. In flexControl a message appears (see Figure 2-35).
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Figure 2-35 Run cannot be started

In case spectra could not be processed, the ProcessQueuer offers error messages and
the faulty spectra are not deleted from theBatch Process dialog. With a double-click on
one of these remaining spectra you can open it in flexAnalysis to investigate the reason for
the error.
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Figure 2-36 Error displayed in Batch Process dialog

Additionally the Process Queuer pops up and shows more or less detailed information
regarding the error. With a setting in the flexConfigurator it is possible to select between 2
log levels, standard and extended. The default setting is Standard. The Process Queuer
log information are automatically saved in the file
C:\BDALSystemData\FAPQLog.csv.
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Figure 2-37 Event log

2.4.4.5 Process Spectra

Themacro Process Spectra offers a simplemethod to (re)processMS-spectra without the
necessity of writing a script. A dialog (see Figure 2-38) contains the most important
processing features. They are the same as the corresponding commands in the different
menus of flexAnalysis. 

Figure 2-38 Most important processing commands

l Calibrate (MS Spectrum): (see section 2.4.5). 

l Copy Calibration (MS Spectrum): (see section 2.4.5.2). 

l Replace Calibration (MS Spectrum): (see section 2.4.5.3). 
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l Find Peaks: (see section 2.4.3.1). 

l Send Spectra to ProteinScape: (see section 2.4.11.3). 

Select one or more analyses in the tree view activate the check boxes of one or more
processings and click the Start button to starts the processing. A message appears
reflecting the current state of the process.

The parameters that are used for processing can be set in the Parameter Editor for each
analysis, respectively.

Note Before using the Send Spectra to ProteinScape command you must have
installed the access to your ProteinScape Server!  How to do this is described
in theProteinScape User Manual. 

2.4.5 Calibrate Menu

Figure 2-39 Contents of the Calibrate menu

The Calibrate menu (see Figure 2-39) is composed of various commands that have an
effect on the calibration of the spectra.
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Table 2-5 Features of the Calibrate menu

Feature
button

Calibration menu
commands Description

Internal Opens theCalibration dialog.

Copy Calibration Copies the calibration of a selected analysis into the
calibration buffer of flexAnalysis.

Replace
Calibration

Replaces the calibration of one or more analyses with
the content of the calibration buffer.

Apply Raw
Calibration

Changes the calibration constants to the ones that
camewith the raw data.

2.4.5.1 Internal

If you want to adjust calibration parameter for a new calibration of a mass spectrum of a
selected analysis use the Internal command, or the corresponding icon of the toolbar. 
The Internal Mass Spectrum Calibration dialog (see Figure 2-40) opens. During the
calibration particular masses of the selected mass spectrum are assigned to
corresponding referencemasses of the loaded calibration list.

Calibration is possible for MS spectra and LIFT spectra, the latter must have been created
with ≥ flexControl 3.0! Old LIFT spectra and FAST spectra cannot be recalibrated in
flexAnalysis because the MS/MS calibration was part of the acquisition system and thus
part of the acquisitionmethod in flexControl. 

flexAnalysis offers threeMS calibration strategies:

l Interactive Calibration, automatic or manual, using calibration lists (MCLs).

l Smart, that is an easy- to- use calibration procedure for optimum results. The
program reappraises the statistical frequency of occurrence of calibrants.

l Statistical Peptide calibration for peptide spectra.

and two LIFT calibration strategies:

l iCal uses ImmoniumIons.mcl as calibration list.

l Statistical LIFT for peptide LIFT spectra
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The calibration strategy is saved in the flexAnalysismethod and spectrummethod, but can
also be changed.

Figure 2-40 Mass Spectrum Calibration dialog – Calibration Strategy “Interactive”

►► To perform a manual internal calibration of a spectrum

1. Load the spectrum and open the Internal calibration dialog.

2. Select the Mass Control Lists that matches to the spectrum mass range and contains
somemasses that are also available in your spectrum.

3. ClickAutomatic Assign or assign masses from the displaymanually to masses from
theMCL.

4. Click the buttonCalibrate to create the new calibration.

5. Click the buttonOK to accept the new calibration and close the dialog.

The commands Copy Calibration (see section 2.4.5.2) and Replace Calibration
(see section 2.4.5.3) can then be used to recalibrate unknown sample spectra.
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Interactive Calibration

The calibrant list shows names and masses of known substances, the corresponding
masses found in the currently active spectrum, and the error in ppm and in Dalton.
Interactive Calibration can be done automatically with the button or manually
with click in the list on one calibrant followed by a click in the spectrum left of the
corresponding peak. Masses of the peak list are then entered in the calibration list and the
error is re-calculated with each new assignment. The error in Dalton is calculated with
current mass reference mass( − ) , the error in ppm is calculated with

× 10
current mass reference mass

reference mass

( − ) 6

.To help you to perform a good calibration, a boxwith
hintsmight appear. E.g. it will ask you to assignmore peaks or to cover a larger mass
range.

Mass Control List Selection

This pull downmenu contains the available calibration lists (MCLs). Only lists with at least
onemassmarked as calibrant are offered. The calibrants of the selected list are displayed
in the box below.

Edit Button

Applying this button opens the Mass Control List Editor (see Figure 2-41), as does the
button on theCalibration tab (see Figure 2-72) in theParameter Editor (see section
2.4.7.5.3). MCLs can be changed and created with this editor. For more information on
how to use and createMassControlLists see Quickstart_MassControlLists.pdf
available on the Compass for flex installation DVD.
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Figure 2-41 Mass Control List Editor

Automatic Assign Button

Peaks from the peak list are automatically assigned to the reference masses; a new fit
result and errors are calculated but not yet applied to the spectrum. If no peak list is
available, this is automatically created before the assignment. The peak finder algorithm
used for automatic calculation is the one currently selected in the processing parameter
editor, sectionMass List Find (see section 2.4.7.5.1).

Calibrate Button

With a click on this button the new fit result, calculated with manual assignment or the
buttonAutomatic Assign is applied to the spectrum (it ismoved in the display).

Undo Button

After the new fit result has been applied with Calibrate it can be canceled with the Undo
button. The original calibration, currently saved in the spectrum is applied again and peaks
are re-annotated.
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Clear Assigned Button

This button deletes the assignments from the calibration list; it does not affect any existing
calibration.

OK and Cancel Buttons

After a calibration has been done, the dialog can be closed with these buttons. OKmeans
"calibrate and close", so even if theCalibrate button has not been applied the calibration is
accepted. Cancel means "undo and close", i.e. even if the calibration has been applied
withCalibrate before, it is not accepted.

Zooming During Manual Assignment

For manual assignment of masses to reference masses it is necessary to click in the
spectrum left to the peak of interest. Therefore it is helpful to zoom automatically the
respective mass range corresponding to the selected reference mass. It is possible to
choose between some relative and absolute zoom ranges.

Note If an entry in the list box is selected, you can use the mouse wheel to select the
next reference mass (or to go back to a previous one). This simplifies the
manual assignment.

Peak Assignment Tolerance

The tolerance defines a mass interval that is used for the calibrant assignment. If the
difference between a reference mass and a peak in the peak list is smaller than the
tolerance, the peak is assigned to the calibrant. If more than one peak of the peak list fits
this criterion the peakwith the smallest mass difference to the calibrant is assigned to the
calibrant.

Calibration Fit Order

Selecting this option performs a linear, quadratic, cubic enhanced or linear correction
calibration calculating of the coefficients c0, c1 (and c2and c3). For linear calibrations c2and
c3are set to zero; for quadratic calibrations c3 is set to zero.
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Properties Button

The Properties dialog shows the current state of the calibration and some general
calibration information. If spectra have been acquired with a flexControl HPC method the
check box High Precision Calibration applied at the bottom is activated (read-only
check box).

Figure 2-42 Calibration Properties dialog

Result Information

Below the calibration list three result fields are shown: the number of used calibrants, the
standard deviation before and standard deviation after the last calibration fit.

If no peaks are found during the automatic peak assignment the following message
appears where possibilities are offered to correct the calibration. A good starting point is to
check that the selected MCL reallymatches to themass range of the spectrum that should
be calibrated. Also, the selected tolerance is often too small for a special data set. This
happens when the flexControl method has not been calibrated for some time, so the
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spectra are acquired with a bad calibration (mass shift) that cannot be compensated with
the chosen flexAnalysis tolerance.

Figure 2-43 Message to repeat automatic assignment with different conditions

The information message Assign more peaks means that the currently chosen
calibration mode (linear, quadratic, cubic enhanced) needs more calibrants to be able to
calculate a new calibration.

Figure 2-44 Assign more peaks message

The information message regarding the mass range coverage means that the currently
already assignedmasses do not cover the acquisitionmass range of the spectrum.

Figure 2-45 Mass range coverage message

Bothmessages can be ignored as long as you go on with assignment of new calibrants.
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Smart Calibration

Figure 2-46 Mass Spectrum Calibration dialog – Calibration Strategy “Smart”

If the option Smart Calibration is selected the calibration dialog looks as shown in Figure
2-46.

SMART is an "intelligent" calibration strategy, which significantly improves the
identification success and the scores for PMFs (Peptide Mass Fingerprints). SMART
calibration requires project specific mass control lists for calibration and background peak
exclusion. Such lists are generated with Bruker ProteinScape software or, on individual
customer request, by the Bruker Software support (maldi.sw.support@bdal.de). Common
mass control lists can also be used as smart calibration lists if they contain more than six
calibrants.

The SMART calibration is an iterative processwhich takes the following points into
account:

l the number of calibrants found in the respective spectrum,

l the likelihood of these calibrants appearing,

l the accuracy of the mass values, as well as their distribution over the required
calibrationmass range.
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The project dependent mass control lists do not only include the peptides, whose
sequences and theoretical masses are known (e.g. trypsin autolysis products, and keratin
fragments), but normally a large number of background peaks. Their sequence is not
known, and their masses are determined by the average obtained from a large number of
well calibrated spectra obtained during such a project. Such background peaks are project
specific and are very dependant on sample preparation (digestion method, staining
method and preparation).

Statistical Peptide

The third calibration strategy, Statistical Peptide, is only useful when peptide spectra are
calibrated.

Figure 2-47 Mass Spectrum Calibration dialog – Calibration Strategy “Statistical
Peptide”

Statistical Peptide is a so-called self-calibration of TOF peptide spectra. It is a powerful
tool, especially in cases, where no internal calibrants are known.

Note A statistical calibration needs no calibrant list!

This strategy is based on the fact that themonoisotopicmasses of peptides are distributed
in a very regular way, at least in the mass range, which is used for protein digest
measurements. The masses accumulate around masses m mean at a distance of
approximately 1.00048 Da. The masses mmean are used as calibrants for all peaks in the
mass list in a statistical calculation of the new calibration constants. 
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2.4.5.1.1 Golden Rules for Statistical Calibrations

Statistical calibrations are applicable for peptides only.  Under good conditions a mass
error of 20 - 40 ppm can be reached.

Themore peaks are available in themass list and the better the distribution of these peaks
over the mass range of interest is, the better is the result of the statistical calibration. As a
rule of thumb about 20 peptide peaks are needed to obtain ameaningful result.

The maximum mass error of the peaks must not exceed about 0.4 – 0.5 Da (500 ppm at
900 Da). At about 0.5 Da the algorithm cannot decide whichmass is concerned.  This can
lead to an incorrect calibration of one Da!

If you feel certain that the external calibration of the given spectrum is significantly better
than 500 ppm you can reduce the peak assignment tolerance accordingly.  This can
slightly enhance the performance of the statistical calibration.

Strong matrix cluster peaks between 700 and 1500 Da can affect the quality of the
statistical calibration results.  This happens because the stoichiometric composition of
matrix clusters and peptides are strongly different.

iCal

The fourth calibration strategy, iCal, is used for the recalibration of LIFT spectra from
peptides.

Figure 2-48 Mass Spectrum Calibration dialog – Calibration Strategy “iCal”
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The calibration is based on a mass control list (ImmoniumIons.mcl ) containing the
masses of abundant immonium ions of peptides (i- type ions).  These are internal
fragments of single amino acids residues.

Note Not every immonium ion will be present in every Lift spectrum!

During calibration routine, the calibrants arematched to the annotated signals and a new
calibration is applied to the spectrum.

Note Manual peak selection is not possible!

The iCal strategy can be used automatically together with the flexAnalysismethod SNAP_
full_process_calibrate_ical.FALIFTMethod.

For iTRAQ8plex samples, a special mass control list is available (iTRAQ8plex_iCAL.mcl)
containing the 8 reporter ions and the mass of the complete label. These ions are very
abundant peaks in the LIFT spectra and well suitable for iCal.

Note For iTRAQsamples use the iTRAQ8plex_iCAL.mcl and not the
ImmoniumIons.mcl!

Statistical LIFT

The fifth calibration strategy, Statistical LIFT, is only useful when LIFT peptide spectra are
calibrated. For details read the Statistical Peptide chapter above.

Figure 2-49 Mass Spectrum Calibration dialog – Calibration Strategy Statistical LIFT
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2.4.5.2 Copy Calibration

With this command the calibration constants of a spectrum can be copied into the
clipboard. Afterwards they can be pasted to another analysis.

1. Select an analysis in the Analysis List Window.

2. Select Copy Calibration . The command copies the calibration of the selected
analysis into the calibration memory of flexAnalysis. Afterwards it can be pasted to
other analysis/analyses. OnlyMS fingerprint calibrations can be copied and transferred
into the calibration buffer. 

2.4.5.3 Replace Calibration

TheReplace Calibration command transfers the calibration from the calibrationmemory
to the selected analyses.

Precondition: A TOF calibration, i.e. the constants c0 , c1, and c2 of an analysis have
already been copied into the calibrationmemory of flexAnalysis (copy calibration).

1. Select one or more analysis/analyses in the Analysis List Window.

2. Select Replace Calibration. The calibration constants are transferred.

Before a calibration is transferred from one analysis to another one, it is checked whether
the high voltages of the ion sources 1 and 2, the lens and reflector voltages of the two
analyses are identical within a range of 0.01 V.  If this is not the case a warning message
appears. Press “No”, if you don’t want to transfer the calibration and “Yes”, if you want to
apply the external calibration despite of themismatch of the calibration voltages.

The latter two sections describe the manual way to do a calibration and transfer it to a set
of sample spectra. This can also be done automatically (within an AutoXecute run) with
two pre-installedmethods: CalibratePeptideStandards.FAMSMethod and
ExternalCalibration.FAMSMethod.

The first one is applied to spectra acquired on a calibration sample; the script of this
method performs the calibration process and copies the new calibration constants. The
second method is applied to spectra that are acquired on the sample spot after (!) the
calibration measurement. The script cares for the transfer of the newly calculated
calibration constants.
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2.4.5.4 Apply Raw Calibration

The Apply Raw Calibration command is used to reset the calibration to those values,
which were originally stored during the acquisition in flexControl. The peak list will be re-
calculated. This command is only available for MS spectra.

After applying and before executing this command a warning message appears (see
Figure 2-50).

Figure 2-50 Warning before applying the raw calibration

2.4.6 Annotation Menu

Figure 2-51 Content of the Annotation menu

The Annotation menu (see Figure 2-51) is composed of various commands that allow
you to attach specific annotations to mass spectra, to modify these annotations and to
remove them again if you do not want them to be saved with the respectivemass
spectrum.
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Table 2-6 Features of the Annotation menu

Feature
button

Method menu
commands Shortcut Description

Annotate ALT Activates the Annotationmode.

Clear Deletes all annotations from the display and
from the Sequence List.

Show mass
differences

Hide/display mass errors relative to
theoretical mass differences 

Preview
Assignments

Spider web mode: screen for all possible
next peaks automatically

Edit Building
Blocks

Opens theBuilding Block Editor

An annotation is attached to one (single-point annotation) or two (difference annotation)
selected data points and is defined by its position in terms of the data coordinates (intensity
and mass). Therefore, when the display range is changed, an annotation moves along
with its associatedmass spectrum. Annotations can be attached to any peak of the peak
list.

Each annotation consists of a value or text entry and a line marker that indicates the m/z
value(s) the respective annotation relates to.

Different annotation types are available depending on the kind of data you wish to
annotate. Mass spectra peaks can be annotated with their corresponding m/z, values of
m/z difference, building block information or text.

2.4.6.1 Annotate

TheAnnotate command, the corresponding icon of the toolbar and the shortcut (Alt)
are used to activate the Annotation mode. The toolbar is expanded with Annotation
features (see Figure 2-52).

Figure 2-52 Annotation toolbar
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These toolbar features are pre-installed, some others, concerning the annotation font and
orientation, can be additionally selected using theCustomize Toolbar (see section
2.4.11.6).

This drop down box offers all available Building Block Sets (the sets can be edited with the
Building Block Editor). Select a set from the list that possibly contains building blocks
that match to the currently selected spectrum.

The Building Block Search Tolerance has to be entered manually; it is possible to
change between Dalton and ppm. The Tolerance is used for the preview assignment
feature (see section 2.4.6.4).

The field Annotation Text can either be filled manually with any text (that is then
transferred into the display) but it is also filled automatically with the Building Block
information that belongs to the Annotation that is just activated in the display (mouse click).
Depending on the selection of theAbbreviation box (see below), the full name, symbol or
abbreviation of the Building Block is shown.

The selection in the Abbreviation box for Building Blocks determines whether the
Symbol, Abbreviation or the Full Name of the currently activated Building Block is shown in
the display and in theAnnotation Text field (see Figure 2-53).
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Figure 2-53 Example of different annotations texts

,

The font and font size, as well as the position and orientation of the annotations can be
determined with these features. The color of theAnnotation label can be changed via the
Tool menu entryColors.

2.4.6.2 Clear

The Clear command and the corresponding icon of the toolbar are used to delete all
Annotations from the spectrum display, as well as the possibly resulting sequences from
the Sequence list.

2.4.6.3 ShowMass Difference

TheShow Mass Difference command and the corresponding icon of the toolbar are
used to show mass differences additionally to the respective Annotation (name, symbol or
abbreviation) in the display. This value shows the mass difference between an assigned
building block and the actual mass difference between the two chosen peaks.
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Figure 2-54 Annotation with and without Mass Difference

2.4.6.4 Preview Assignments

ThePreview Assignments command and the corresponding icon of the toolbar offer
a preview on all possible distances (to higher and lower masses) depending on the
entered search tolerance that can be calculated for one (!) starting peak together with the
selected Building Block set (see Figure 2-55). To see the preview for onemass

l make sure that you have a peak list,

l activate the Annotationmode, and activate the Preview Assignments button,

l click on a peak in the spectrum display and keep the left mouse button pressed.

Thematching Building Blockswill be shown. You can choose one of these and release the
mouse button to get this annotation.

Figure 2-55 Example for possible assignments for the peak 517.18 Da
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2.4.6.5 Edit Building Blocks

The Edit Building Blocks command is used to start the Bruker Daltonics Building
Block Editor application which allows you to view and edit the currently available building
block sets to be used to automatically interpret m/z differences.

Selecting this command starts the Building Block Editor and loads the first of the
alphabetically ordered building block sets shown in Building block sets. The building blocks
contained in this set are listed in Building Blocks along with their Full name, Abbrev(iation)
and chemical Formula. Additionally, the Symbol is shown which appears in the data
window when the Annotationmode is active.

Various Bruker Default building block sets are available. A <BrukerDefault> appendix to
the building block set name indicates these. You cannot alter or delete them. However,
you can set up user specific building block sets by copying such a Bruker Default set to a
new file name and then modifying the copy according to your own requirements or by
creating a completely new building block set

Figure 2-56 Building blocks contained in the loaded building block set
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2.4.7 Method Menu

Figure 2-57 Contents of the Method menu

The Method menu (see Figure 2-57) is composed of various commands to configure
method parameters.
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Table 2-7 Features of the Method menu

Feature
button

Method menu
commands Shortcut Description

Open Opens a processingmethod.

Save Saves the open processing method with the
same file name if not write protected.

Save As Saves the open processing method with a
new file name.

Run Script F2 Runs the Sax Basic script of the open
processingmethod on the selected analysis.

Edit Parameters ALT+F2 Opens themethod parameter editor.

Edit Processing
Parameters

SHIFT+F2 Opens theProcessing Parameter Editor.

Edit Script CTRL+F2 Creates or edits the Sax Basic script that
belongs to the open processingmethod.

Select Default Opens a dialog to select automatically
attached default processingmethods.

Methods are central elements in flexAnalysis. They determine the processing of the
analysis. An analysis is always associated with onemethod. This assignment takes place
during the load process and depends on several criteria.

First of all it depends on whether the analysis has already been processed and saved with
flexAnalysis or not.  If the analysis has once been saved with flexAnalysis a file called
analysis.FAMethod is available (next to the fid file in the spectrum tree) that contains all
method settings (parameter and script) that were active at saving time. This file is loaded
when the analysis is opened again. In this case the spectrum sample name is shown in the
status bar at the bottom of the GUI.

If the analysis has never been saved with flexAnalysis before the program checkswhether
the acquisition program flexControl (Save As dialog) or AutoXecute (Processing tab or
FA MS/FA MSMS column) has specified a flexAnalysis method after the acquisition. In
this case this method is assigned.  If the assignment fails either because the method is
broken or does not exist the Default method (see section 2.4.7.8) is loaded, because it is
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not possible to open a spectrum without a method. In all these cases the name of the
method is shown in the status bar at the bottom of the GUI, at least as long as the script is
running.

In some cases the assignment of the Default Methodmay fail, too. Then so called Default
Values (and an empty script) are loaded to have access to the data and to assign working
methods manually. This failure is shown with the information <Default Values> in the
status bar at the bottom of the GUI.

A flexAnalysismethod consists of two parts, themethod parameters (see section 2.4.7.5))
and the method scriptmethod script (see section 2.4.7.7). The method script determines
the sequence of processing procedures performed with your analysis, while the method
parameters configure each processing procedure.

Note The peak list layout is also amethod parameter.

If an analysis that has never been processed in flexAnalysis before is opened the method
script is executed automatically and the Script in progress dialog is shown (see Figure
2-59).

To get more information on the flexAnalysismethod concept please refer to the Quickstart
flexAnalysis Method Concept.pdf. 

2.4.7.1 Open

The Open command and the corresponding icon of the toolbar are used to open the
Open flexAnalysis Method dialog (Figure 2-58) to choose a new flexAnalysis method. 
The new method replaces the previous one. The name of the current processing method
is displayed in the status bar of the GUI (see section 2.3) title bar of theMethod
Parameters dialog box (see Figure 2-60), that appears when selecting theEdit
Parameters command from the Method menu, as well as in the title bar of the Method
Script Editor (see Figure 2-77) and in the status bar of the GUI. Here it is displayed as
long as the analysis has not been saved.
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Figure 2-58 Open flexAnalysis Method dialog box

►► How to assign a method

There are different ways to assign a new method to a selected analysis. This may be
required if it is necessary to use amethod that is different to the current method settings.

Assigning amethod with the open command:

1. Select the analysis that shall obtain a new method.

2. Click the button  .

-or-

1. From theMethodmenu, selectOpen.

2. Select themethod you want to apply.

3. ClickOpen.
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Attaching a processing method of another analysis with copy and paste (see section
2.4.2):

It is not required that thismethod exists in the flexAnalysismethods directory.

1. Mark the analysis whosemethod you want to attach in the tree view.

2. Right-click the selection and selectCopy or click the button .

3. Mark the analysis that shall obtain a new method in the tree view.

4. Right-click the selection and selectPaste or Paste Special or click the button .

2.4.7.2 Save

The Save command, or the corresponding icon of the toolbar are used to save
changed method settings to the same file name. This overwrites the original (not write
protected) method. If the opened method has been changed but not saved, it is shown by
the '(modified)' indicator, a *- symbol, which is shown in the title bar of the Method
Parameters dialog box or in the Script Editor . If a modified method is not saved the
current parameter settings for an analysis will be saved when this analysis is saved. For
spectra that are available in the XMass format the file Analysis.FAmethod is created
in the analysis tree. Spectra that are available in the new container format also have a
method assigned, i.e. parameters and a script, but it cannot be found on the hard drive.

Selecting the Save command removes the '(modified)' indicator previously appended to
the title bar of theMethod Editor.

Note If the original method is write-protected the Save command is not accessible
and theSave As dialog opens. 

2.4.7.3 Save As

TheSave As command is used to create a new processingmethod by saving a changed
method to a new or already existing file name. Enter a new or select an existing processing
method name in the appearing dialog.

The new file name will be displayed in the status bar at the bottom of the GUI and in the
title bar of the corresponding Method Parameters dialog box instead of the previous
method name.
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2.4.7.4 Run Script

The Run Script command, the corresponding icon of the toolbar, and the short cut
(F2) are used to run the Sax Basic script that belongs to the currently loadedmethod of the
selected analysis.

The running of the script is indicated on a progress indicator (see Figure 2-59). 

Figure 2-59 Running method script

The script processes the spectrum according to the particular processing operation(s) and
parameters defined in the script and theParameter Editor, respectively.

To view a script before running, the flexAnalysis Script Editor (see section 2.4.7.7) can
be opened. The script can then be started directly from here.

2.4.7.5 Edit Parameters

TheEdit Parameters command, the corresponding icon of the toolbar, and the short
cut (Alt + F2) are used to open the Method Parameters dialog for the spectrum that is
currentlymarked in the tree view.  According to the selected kind of spectrum (MS, LIFT,
and FAST) the editor offers a variable number of tabswith respective features.

Note All features contained in this section are method parameters. If one parameter
is changed and you want to use it in future, you have to save themethod.When
only the currently active spectrum is saved, the settings are not automatically
available for other spectra! If you want to use a special set of parameter for all
your spectra, you have to create a new method (and save it with a new name).

2.4.7.5.1 Process

The currently active parameters for peak finding, smoothing and baseline subtraction can
be seen via the Process tab as Active Settings. You may select a different parameter
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set from the drop down box or create own sets and save themwith new names.When one
of them is selected here its content will naturally remain selected when you click Apply or
close the Parameter Editor with OK, only its name changes toActive Settings and the
content of the set becomes part of the method (nevertheless don't forget to save the
method afterwards!). Thismeans that the name of a previously selected parameter set will
not be shown anymore, but the parameters are still active!

Figure 2-60 Process tab

Since Compass 1.2 for flex, i.e. flexAnalysis 3.0 and flexControl 3.0 the peak detection
algorithms as well as processing settings like baseline subtraction and smoothing are
defined in Processing containers (*.prp) that are edited via theProcessing Parameter
Editor (see Figure 2-61). These parameter containers can be created, edited and used
from flexAnalysis, flexControl and AutoXecute. Detailed information can be found in the
corresponding Quickstart_ ProcessingParameterMethods.pdf . For
flexAnalysis methods it is important to know that the METHOD has to be saved when
parameters have been changed, even the prp-file is already saved!

►► The workflow for changing peakfinder settings for a flexAnalysis MS
method is:

1. Load anyMS spectrum.

2. Load anyMSmethod.

3. Open theParameters Editor.

4. ClickEdit to open the prp editor, change for example the Signal/Noise value.

5. Close the prp editor.

6. Close theParameters Editor by clickingOK.

7. Save themethod using theSave (As) option in theMethodmenu.
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Note Even when a processing parameter container (prp) has been saved with a
name, this name won't be shown when you open the Parameters dialog of a
method again. Nomatter what you have entered, the only term that you will see
is Active settings. Of course your settings are stored and used, but they lost
their name and became part of the flexAnalysis method. You don't have to
select the parameter set again!

Note It is not necessary and in a lot of cases also not recommended to use the same
parameter container in flexControl and flexAnalysis, since both programs do
different things (acquisition/optimization vs processing).

Mass List - Find

The flex programs support three different detection algorithms:Centroid, SNAP, and
Sum. These are used to detect mass peaks, calculate the corresponding m/z values and
many other peak parameters, such as intensity or resolution.

Figure 2-61 Processing Parameter Editor - Mass List Find

Any peak finder is optimized for a specific task. In most cases if the elementary
composition is known (see Figure 2-64), it is recommended to use SNAP for detection of
groups of isotopic peaks. Centroid is often used in case of protein spectra and benefits in
definingmass accuracy. The SumFinder is used for time critical applications. 

The following four parameters are the same for all algorithms:
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Signal to Noise (S/N) Threshold

The S/N is defined as the height of the mass peak above its baseline relative to the
standard deviation of the noise, i.e. peak height / (3 x σ)  (σ: standard deviation of the
noise).  The higher the threshold is the less peaks are found.  However, if the selected
value is too small, noise may be regarded as peaks. The recommended S/N range varies
from 3/1 to 10/1.  In case of 10/1 you can be sure to have eliminated nearly all the noise.

Relative Intensity Threshold

The Relative Intensity Threshold is a level in percent referring to the base peak, which is
the largest peak in the spectrum.  In cases, where it is not clear, whether the base peak
refers to the sample or not, the recommended value for this threshold is 0 (zero).

Minimum Intensity Threshold

A peakmust have at least this intensity to be detected and annotated from the peak finder.
It is useful for example for Imaging runs where the fuzzy control is de-activated and
spectra that only consist of electronic noise are acquired. They show a flat baseline and
some spikes with small intensities that will be annotated and will distort the picture. The
Minimum Intensity Threshold allows ignoring these.

Maximal Number of Peaks

This is the maximal number of peaks that shall be detected by any of the three detection
algorithms.  In case of SNAP this value is an additional filter regarding the Quality factor,
for all other algorithms the peakswith the highest intensity will be selected.

Additionally each peak detection algorithm has also some special parameters that can only
be adjusted, if the respective algorithm has been chosen from the drop down list.

Peak Detection Algorithm Centroid

The peak finding mechanism for Centroid (see Figure 2-62) uses the first and second
derivative to detect a peak. For the peak position a specific cut off level above the baseline,
Percent Height, has to be specified. A value around 80% is recommended. When using
Centroid the baseline has to be subtracted temporary. It is added afterwards. This
baseline subtraction algorithm has to be selected on theMass List Find tab.
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Note The algorithm chosen here is not used for the “real” baseline subtraction, which
has to be specified via Processing Baseline Subtraction.

Other specialCentroid parameters are:

l Peak Width

o The parameter Peak Width is not a threshold but an expectancy value. Peaks
having this width are expected in the spectrum and will be accepted. If the width
value is set too high, small peakswill be regarded as noise.

l Height

o This value determines the upper part of the peak that is used to locate the peak
position on the x-axis, i.e.m/z. If the separated peak area is symmetric the peak
position will be found centric, otherwise themaximum is shifted.

Figure 2-62 Processing Parameter Editor (Mass List Find: Centroid)
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Peak Detection Algorithm SNAP

SNAP — Sophisticated Numerical Annotation Procedure — (see Figure 2-63) searches
for known patterns in the measured spectrum and performs its own internal baseline
correction and noise determination.  Note: this internal baseline correction and noise
determination is only a calculation. Thismeans if this is not defined explicitly; the peakswill
only be labeled.

With SNAP groups of peaks are detected in high throughput proteomics, e.g., for
identification of isotopic patterns and exact calculation of the monoisotopic masses. 
Monoisotopic masses are the basis for database search and DeNovoSequencing, which
allows elucidating structure and sequence of a particular peptide if database search for
MS/MS data failed.

SNAP calculates the isotopic distribution of a given mass, charge and mean molecular
constitution and uses the resulting isotopic pattern for a nonlinear fit that delivers the
monoisotopicmass in the end.
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Figure 2-63 Processing Parameter Editor (Mass List Find: Snap)

Quality Factor Threshold

The parameter Quality Factor Threshold describes the reliability of a peak.  It is a
composition of peak intensity and consistency with known isotopic patterns. It is not
possible to give a recommendation for this value; the best is to have a look on it in some
representative spectra and find out the size.

SNAP average composition

The drop down menu SNAP average composition allows selecting a composition.
Existing compositions can bemodified; compositions of other averaged substance classes
can be added. Modifications of Bruker defaults have to be saved to a different name. 
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Figure 2-64 List of SNAP average compositions

For peptide applications a composition called Averagine is defined.  The conceptual
meaning of the word Averagine (see Figure 2-65) and the term C 4.9384 N 1.3577 O
1.4773 S 0.0417 H 7.7583 is the averaged composition of molecules of the 21 amino acids
corresponding to their abundance ratio. This creation is denoted the first Building Block
and is always located in the first row (see Figure 2-65).

To edit a Building Block click .

Figure 2-65 The pre-installed average composition Averagine

SNAP uses this average composition as often as it is necessary for approximation to the
molecule under investigation.  If a second composition is defined that is a mass existing
only once in a monomer, SNAP uses this one exactly once for mass determination.  The
Second Building Block is always located in the second row (see Figure 2-65). 

Fragment Peak Width

This parameter is used to confine a peak to a particular width thus excluding broader
peaks from the peak list. 

SILE Mass Difference(s) (H –L)

Enter one or more values (separated by a semicolon) to define the mass difference
between the Heavy (H) and Light (L) isotopes of the labeling reagent.
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The SILE mass difference(s) defines the m/z distance between the two or more labeled
forms. E.g. for 18^Odigest labeling it would be one and two times

m/z (18^O) - m/z (16^O) = 2.004 and 4.008.

The knowledge about the SILE mass differences is used for an improved S/N threshold
and the internal judgment of the presents of overlappingmonoisotopic peaks.

SILE Partner SN Threshold

The SILE Partner S/N Threshold allows the definition of a second S/N threshold which is
checked for SILE partners. If there are two SILE partners only one has to match the
normal threshold. For the second partner it is enough if it is large enough to match the
SILE partner SN threshold. This gives a better dynamic range for the observable
regulation without adding toomany noisy peaks.

Peak detection algorithm Sum

The Sum peak finder (see Figure 2-66) uses a time-saving approach while calculating so-
called pseudo derivatives instead of real derivatives as known from Centroid.  If the
pseudo slope exceeds a certain threshold, a peak is regarded as peak. The Sumalgorithm
makes internal use of the configurable baseline correction and noise calculation to select
peaks and to calculate signal-to-noise ratios. The configurable parameters are explained
with the other algorithms.
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Figure 2-66 Processing Parameter Editor (Mass List Find: Sum)

Mass List Edit

Figure 2-67 Mass List Edit – use Mass List Find as sensitive as possible

The main difference between the Mass List Edit tab and the Mass List Find tab is the
checkbox Use specific parameters for peak picking. If this checkbox is not selected
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(see Figure 2-67) all parameter settings that are currently selected in Mass List Find are
used for theMass List Edit procedure, except the Threshold parameters, which are set
to zero. This has the effect that the peak finder, which was used for aMass List Find, is as
sensitive as possible in order to detect additional peakwith Mass List Edit manually.

Figure 2-68 Mass List Edit – define special values

If the checkbox is activated (see Figure 2-68) different parameters can be selected. The
Edit field Maximal Number of Peaks is deactivated because only one peak is detected at a
time.

Processing Smoothing

The settings for Smoothing process can be adjusted in the section Smoothing. 
flexAnalysis supports three different smoothing algorithms: Savitzky-Golay, Gauss, and
Chemical Noise. Which one is used depends on the application. 

For all filters the smoothingWidth can be chosen. TheWidth range is from 0 to 100, the
user is asked to find out the best fitting value.
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TheCycles determines the number of smoothing processes on one analysis. One cycle is
recommended. This parameter is not applicable together with the algorithmChemical
Noise.

The idea of the Savitzky-Golay algorithm is to calculate polynomials in the neighborhood of
each data point to get a smoothing of the data. This can be formulated as

° Σy c y=
i k M

M

k i k=– +

with coefficients ck . The parameter M in the formula is calculated from the given m/z
smoothing width. The number of smoothing cycles can also be chosen which gives the
option to apply this smoothing filter multiple times.

Figure 2-69 Method parameters – Smoothing

Processing Baseline Subtraction

The settings for Baseline Subtraction processes can be adjusted in the sectionBaseline
Subtraction (see section 2.4.4.2). Two different algorithms are offered:Median and
TopHat. A deprecated algorithm is ConvexHullV3.

Page 94 of 176 flexAnalysis 3.4 User Manual Revision 1



Bruker Daltonik GmbH 2 Graphical User Interface (GUI)

Figure 2-70 Method parameters – Baseline Subtraction

The algorithm Median (recommended for FAST segment spectra and polymers) is
determined through the parameters Flatness and MedianLevel. A spectrum that will be
baseline subtracted is divided into a number of segments. The minimal number of
segments is 1, i.e. Flatness equals zero. The maximal number of segments is 100, which
corresponds to a Flatness of 1.  A strong baseline drift is associated with high Flatness
values.

The parameter Flatness influences the number of parabolas used to explain the baseline
and the flatness of the resulting spectrum, which is obtained by subtracting the baseline
from the spectrum. The larger the flatness value the finer the baseline will approach the
spectrum.

The following values are recommended for Flatness:

0.0— for totally flat spectra without baseline drift,

0.1— for protein spectra, and

0.8— for digest spectra, recorded in reflector mode.

TheMedian Level allows shifting the baseline relative to the data. By definition, if we have
100 data points, the median (a common statistical size) is the value of data point 50 after
the data points are sorted by their y values. If we have a very dense spectrum, then the
sorted data point #50 can already be something that is in the data level, well above the
baseline. In these cases, we can tell the software not to use the median as defined (data
point #50), but, say, use the value of data point #30, which is then supposed to be part of
the baseline, and not part of the data.
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The algorithm TopHat constructs the baseline by means of morphology operators. The
baseline of the spectrum is obtained in two steps: first each data point is replaced by the
minimum value of the spectrum within n data points, which gives the so called “erosion”.
Then within the same number of data points, each value is replaced by the local maximum
of the minimal values giving the “opening” of the spectrum, which is the baseline. The
number of data points over which the minimum and maximum value is searched for is a
function of themass and is increasing in a way to get a good removal of the baseline but to
minimize the distortion of the peaks.

TopHat should not be used for protein spectra.

2.4.7.5.2 FAST (only for FAST Segment Spectra)

Figure 2-71 Processing Parameter Editor (FAST)

The FAST tab (see Figure 2-71) is only available for a FAST Segment analysis. This tab
allows deciding if smoothing and baseline subtraction are performed before the FAST
segments are pasted. If both functions are selected first smoothing is performed. The
algorithms used for these processing procedures are taken from theProcess tab.

Note Please use Median as baseline subtraction algorithm if you want flexAnalysis
to perform a baseline subtraction before pasting.
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2.4.7.5.3 Calibration

Figure 2-72 Processing Parameter Editor (Calibration)

The parameters selected and adjusted in the Calibration tab determine the results of the
internal calibration. The settings correspond to the settings in the Internal Calibration
dialog (see section 2.4.5.1). The Calibration tab in the Parameters Editor is used in
context with methods and automation, whereas the Internal Calibration dialog is used
for manual calibration. Nevertheless both dialogs contain the same information. Changes
done in one of them are transferred to the other!

Select first the calibration strategy you want to use.

The adjustable parameters on this tab have been explained in detail in section 2.4.5.1. The
pull down menu Mass control list contains predefined calibration lists that can be used for
recalibration. The lists can bemodified with theEdit button. TheMass Control List
Editor opens and shows the selected list (see Figure 2-73). 
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Figure 2-73 Mass Control List Editor

Masses can bemarked as calibrants by activating the corresponding checkbox.

Note:

l Only lists with at least onemass marked as calibrant appear in the drop downmenu
Mass control list.

l The Tolerance values are used for Background identification aswell as for calibrant
assignment.

l When amass control list was opened from theCalibration tab or dialog only the
Calibrant column is shown and masses can only be marked as Calibrant. When
you want to mark them (additionally) as background masses you have to open the
Mass Control List Editor via theMass Listmenu!

Apply to import an entire peak list into the editor. This list may be saved and
also used as calibration and/or background list. 

A pre-installed, i.e. write protected mass control list can be saved with another file name. 
The new file is added to the MassControlLists directory and can now be used from all
programs that work with MCLs.
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The same mass control lists that are available in flexAnalysis are also available in
flexControl (Calibration tab) and AutoXecute (Evaluation tab). So, if a list is changed in
one of these programs, this change is also available in the other programs.

For information about the other features of the Recalibration Masses tab please refer to
section 2.4.5.

2.4.7.5.4 Mass List Layout

Figure 2-74 Processing Parameter Editor (Mass List Layouts)

flexAnalysis offers 10 parameters that may be displayed in the Mass List Window. The
choice can be done via the Layout tab. The layout is part of the flexAnalysismethod.  So if
you want to change it permanently for use with other spectra save the method (!)
afterwards.  If only the just opened analysis is saved, the layout setting refers only to this
analysis (because it is saved in the file Analysis.FAmethod that only belongs to this
analysis).

l The pull down list can be opened with the buttonNew (Insert) .
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l The button Delete is used to remove a peak property from the Mass List
Window.

l The button Move Up or the related short cut (ALT+Up Arrow) and the button

Move Down or the related short cut (ALT+Down Arrow) is used to change the
arrangement of the displayed peak properties.  

Note Some peak finding results are specific to a certain peak finding algorithm, e.g.
the Quality Factor. If the parameter column is shown and the peak list has been
created for example with SNAP, the Quality Factor column remains empty.

2.4.7.5.5 SmartFormula List Layout

Figure 2-75 Processing Parameter Editor (SmartFormula Layouts)

flexAnalysis offers 19 parameters that may be displayed in the SmartFormula List
Window. The choice can be done via the SmartFormula List Layout tab. The layout is
part of the flexAnalysismethod.  So if you want to change it permanently for use with other
spectra save the method (!) afterwards.  If only the just opened analysis is saved, the
layout setting refers only to this analysis (because it is saved in the file Analysis.FAmethod
that only belongs to this analysis).

l The pull down list can be opened with the buttonNew (Insert) .

l The button Delete is used to remove a peak property from the Molecular
Formula Result List Window.
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l The button Move Up or the related short cut (Alt + Up Arrow) and the button

Move Down or the related short cut (ALT+ Down Arrow) is used to change the
arrangement of the displayed peak properties.

For details on the SmartFormula parameters, please refer to section 2.4.11.4.

2.4.7.5.6 Display

Figure 2-76 Processing Parameter Editor (Display)

In this dialog the number of displayed digits for masses in the display and the Mass List
Window (peak list) can be changed.

Checkbox Replace Original

When this box is activated (default setting) the new result spectrum (after baseline
subtraction or smoothing) replaces the previous original spectrum in the Analysis List
Window. The spectrum color remains the same. No additional spectrum is displayed.

If this box is not selected an additional spectrum is attached to the tree view with different
color due to the color hierarchy.

2.4.7.6 Edit Processing Parameters

The Edit Processing Parameters command, the corresponding icon of the toolbar ,
and the short cut (SHIFT+F2) are used to open the flexAnalysis Processing
Parameter Editor (see section 2.4.7.5.1).
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2.4.7.7 Edit Script

The Edit Script command, the corresponding icon of the toolbar , and the short cut
(CTRL+F2) are used to open the flexAnalysis Sax-Basic Script Editor . This is an
interactive design environment to develop, test, and execute Sax-Basic scripts. Sax Basic
is Visual Basic for Applications™ compatible. Scripts are used to process analyses
automatically.  In the flexAnalysis environment, scripts are part of an analysis or amethod. 

The contents of a script are normally processing instructions for a particular analysis the
method belongs to. 

Note It is important to remember that to perform processing on any spectra, the
relevant commands must be available in the method script. For example, this
means that it is not sufficient to just select a smoothing algorithm, the method
script must contain the command "perform smoothing". If you are not sure how
to implement special processing in a method script, please contact Bruker at
maldi.sw.support@bdal.de to discuss your requirements.

General information about Sax Basic Scripting can be found in the corresponding Help file.
For detailed information about Sax Basic Scripting please refer to the flexAnalysis
ScriptingManual (# 263783).

On launching the Script Editor flexAnalysis loads the script of the processing method
currently assigned to the selected analysis. The Script Editor 's title bar shows the name
of the open processing method and the analysis name in parentheses.  In case of a
modified but not yet savedmethod, the '(modified)' indicator is appended to themethod
name.

Figure 2-77 Example of a Basic script
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2.4.7.8 Select Default

Every spectrum that is opened in flexAnalysis needs to have a flexAnalysis method. This
method is automatically assigned on different ways (depending on save processes in
flexControl, AutoXecute, or flexAnalysis that occur before), so the user is not requested to
do anything.

During the manual saving in flexControl it is possible (and sometimes recommended) to
indicate a flexAnalysis method that is used for post processing later on. If no method has
been indicated each spectrum automatically gets a default method assigned during the
load process. This default method is determined in the dialogDefault Method Selection.
For five possible spectra types, suitablemethods are available (see Figure 2-78).

Figure 2-78 Default methods that are assigned to spectra that have no method

Themethods ParametersOnly contain a set of suitable parameters and an empty script.
For this reason (empty scriptà no commands) no processing and especially no saving
takes place if a spectrum gets “ParametersOnly” assigned.

The pre-installed default settings are ParametersOnly for MS spectra and SNAP_full_
process for LIFT spectra. Certainly this can be changed, especially if the user does not
want a script running for every spectrum that is newly loaded.
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Note When spectra are acquired with an AutoXecute run it is recommended to
assign flexAnalysis methods during the run, so that they are automatically
processed (peak find, recalibration, smoothing baseline subtraction, and so
on). Otherwise the spectra would only be saved to the hard drive.

2.4.8 FAST Menu

Figure 2-79 Contents of the FAST menu

The FAST menu offers FAST specific operations and is only available if a FAST segment
analysis or FAST analysis is unambiguously selected. For all other spectra types themenu
entries are not selectable. To display FAST segments with their correct mass values
flexAnalysis is capable to recognize the analysis type during loading.

Table 2-8 Features of the FAST menu

Mass List menu commands Description

Paste Segment Spectra Pastes all segments to one spectrum.

Change Parameters To change parent and segment parameters.

Delete Segment Spectra Deletes segment spectra from hard disk.

2.4.8.1 Paste Segment Spectra

The Paste Segment Spectra command is used to paste FAST segment spectra to one
linearized FAST spectrum.

Raw data (fids) are used in the paste process. The following rule is applied for pasting: 
First flexAnalysis uses the penultimate segment (n-1) until massmmax, and then follows
the last segment (n) without overlapping both segments. 
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Figure 2-80 Example of a segment spectrum before and after pasting

The paste procedure results in a new analysis that is also shown in the tree view. This
analysis contains all spectra, which arise from multiple use of the Paste command
referring on the same FAST segment analysis.

Figure 2-81 FAST segments and corresponding pasted FAST spectrum
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Results are not automatically saved after manual pasting. On saving an analysis, which
contains the result of a paste procedure, a result spectrum of this analysis is saved in a
directory: samplename\<parentmass>.FAST.FAST.

Figure 2-82 Result spectrum folder of a paste procedure

Note If there is already a spectrum in
samplename\<parentmass>.FAST.FAST it will be overwritten, because
on the hard drive at any time only one result spectrum is allowed.

2.4.8.2 Change Parameters

The Change Parameters command is used to change the parent mass, the FAST
segment parameters per segment, for example the segment range, and to recalibrate
FAST segment spectra afterwards. The operator can apply a new calibration file for
recalibration in case of Segment Spectra acquired with flexControl versions < 2.0. 

TheChange Parameters command opens a dialog that lists the segment boundaries in
m/z. Applying the radio button FASTLow / FASTHigh the same segment boundaries are
shown in the relation FASTLow / FASTHigh.
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Figure 2-83 Changing segment ranges using m/z values

2.4.8.3 Delete Segment Spectra

The Delete Segment Spectra command is active if FAST segments are successfully
pasted and the pasted spectrum has been saved. The command closes all FAST
segments and deletes them from the hard drive. This feature corresponds to erasing a
directory. Applying this command opens a message (see Figure 2-84). Afterwards only
the pasted FAST spectrum remains on disk!

Figure 2-84 Message before erasing the folder
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2.4.9 View Menu

Figure 2-85 Contents of the View menu

2.4.9.1 Viewing Mass Spectra

The perspective of the loaded mass spectra can be shown using the Overlaid, Stacked
and List options.

InOverlaidmode all mass spectra share the same x-y-axes.

InStackedmode all mass spectra share the same x-y-axes, but have different z- axes.

In List mode each mass spectra is displayed in its own list window. In the shortcut menu
appears the new option List Windows to select, how many spectra will be shown at once.
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Table 2-9 Features of the View menu

Feature
button

View menu
commands Shortcut Description

Auto-Scaling ALT+F9 Toggles the abscissa and, if possible, the
ordinate of the active data window
between auto-scaling andmanual
scaling.

Scale to
entire
Spectrum

CTRL+F9 All currently displayed spectra are
completely shown; however auto scaling
is not switched on.

Horizontal
Auto-Scaling

Returns frommanual horizontal scaling to
auto scaling.

Vertical
Auto-Scaling

Returns from manual vertical scaling to
auto scaling.

Set Display
Range

Sets the data display range for the active
data window.

Zoom F9 Zooms the selected data range.

Zoom X SHIFT+F9 Zooms only in x direction

Undo
Zooming

ALT+LEFT
ARROW

Undoes the last zooming step.

Redo
Zooming

ALT +RIGHT
ARROW

Redoes the previous unzoom step.

Toolbars Shows, hides, or customizes toolbars.

Status Bar Shows or hides the Status Bar.

2.4.9.2 Auto-Scaling

The Auto-Scaling command, the corresponding tool button and the short cut (Alt +
F9) are used to toggle abscissa and ordinate in theMass Spectrumwindow between auto-
scaling and manual scaling.  On selecting this command, the auto-scaling mode takes
effect or not.  Auto-scaling means that the display range of both axes is automatically
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adjusted to display the maximum measured values.  When this mode is active, the
corresponding tool button in the toolbar is highlighted. 

Note When using this command in theMass Spectrumwindow, the operator cannot
individually set the auto-scaling status for the y- or x-axis.

Any changes of the y- or x- axis display range will deactivate auto- scaling of the
corresponding axis/axes.

Auto-scaling can be activated and de-activated with double-click in the display or beneath
and next to the x- and y-axis. Additionally the buttons and can be used.

2.4.9.3 Scale to Entire Spectrum

The Scale to Entire Spectrum command and the short cut (CTRL+F9) are used to
return from a zoomed section of a spectrum to the total spectrum. This command has the
same effect as Auto-Scaling, however the auto-scale mode is not switched on after this
command is executed. 

2.4.9.4 Horizontal and Vertical Auto Scaling

The Horizontal/Vertical Auto-Scaling command and the corresponding feature button
/ are used to display the entire (mass/intensity) spectrum in theMass Spectrum

Window.

2.4.9.5 Set Display Range

TheSet Display Range command is used to specify ranges for the x- and y-axis. TheSet
Display Range dialog box opens, which allows setting the mass range and the intensity
scale when the checkboxesAuto-Scaling are not selected.

Figure 2-86 Set Display Range dialog box
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2.4.9.6 Zoom

The Zoom command, the corresponding icon of the toolbar, and the short cut (F9) are
used to zoom a section of the display range in the display.  The stack facility is also
available here, so the operator can toggle between theUndo Zooming andRedo
Zooming commands.

The Zoom In function is active after the corresponding tool button is applied. 

Consequently the mouse pointer converts automatically into the Zoom In pointer
inside the spectrumwindow. 

The Zoom In function also becomes active when the mouse pointer is inside the Mass
SpectrumWindow and the SHIFT key is pressed.

2.4.9.7 Zoom X

The Zoom X command, the corresponding icon of the toolbar and the short cut (Shift
+ F9) are used to zoom spectra or peaks in x-direction. The ordinate value remains
unchanged.

2.4.9.8 Undo Zooming

The Undo Zooming command, the corresponding icon of the toolbar, the short cut
(ALT+ LEFT ARROW), and a simple mouse click into theMass Spectrum window (when
the Zoom mode is active) are used to reverse the last zooming step that was performed.
flexAnalysis is able to put the last twenty zooming steps of the current session into a
particular stack. 

This allows the operator to go back to previous zoom steps by continuously selecting
Undo Zooming until the desired display is reached. When the last step from the stack is
reached, flexAnalysis deactivates this function. 

2.4.9.9 Redo Zooming

TheRedo Zooming command, the corresponding icon of the toolbar, or the short cut
(ALT+RIGHT ARROW) are the counterpart of the Undo Zooming function and are used
to retrieve a previous step reversed with the Undo Zooming command. On selecting
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Redo Zooming, the display range switches to the zooming step that was performed
previously. 

Also here flexAnalysis stacks up to twenty last zooming steps performed during the current
session. 

2.4.9.10 Toolbars

The Toolbars command opens the Toolbars dialog box (see Figure 2-87).  This feature
is used to show, hide, or customize toolbars.  This is done by selecting or clearing the
corresponding check box, which shows or hides the respective part of the toolbar on the
GUI. 

Figure 2-87 The Toolbars dialog box

The list boxToolbars shows all the toolbars currently defined (defaults as well as custom
toolbars). Each toolbar has a check box in front of it indicating its current display status.

The buttonNew allows users to create a custom toolbar.

Figure 2-88 New toolbar dialog
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2.4.9.11 Status Bar

TheStatus Bar command is used to show or hide the status bar at the bottom of the GUI. 
When the status bar is visible, it is indicated by a highlighted check mark in front of this
command. 

2.4.10 Report Menu

Figure 2-89 Contents of the Report menu

TheReportmenu is composed of commands to report processing results.

Feature
button Method menu commands Shortcut Description

Preview Preview the report.

Print CTRL+ P Print the report.

Save As PDF Save the report as a PDF file.

Save As HTML Save the report as an HTML file.

Report Designer Launches the Report Designer.

2.4.10.1 Print Preview

The Print Preview command and the corresponding feature button of the toolbar
open theReport Preview dialog (see Figure 2-90). The printer and special report layouts
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can be chosen here. The button Preview at the bottom of the dialog opens the actual
preview and displays the selected spectrum, as it would appear in the printout.

Layouts can be created, designed, and modified with the Report Designer. The button
Report Designer starts this application. It is described in section 2.4.10.1 and in the
Report Designer User Manual on the installation DVD.

Figure 2-90 Preview Report dialog

If user- defined report layouts are created on the basis of pre- installed layouts, it is
recommended to store the original layout before modifications are made and to save the
modified file with a new name. Additionally be aware to use the default file structure to
save report files: D:\Methods\Report Layouts\flexAnalysis.
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If flexAnalysis is installed on a standalone system the path probably depends on the
adjusted Regional Setting of the operating system. Otherwise the saved files cannot be
located

2.4.10.2 Print

The Print Command, the corresponding toolbar button and the short cut (CTRL+P)
open thePrint dialog (see Figure 2-91). A printout can be done from here by clickingOK.

Figure 2-91 Print Report dialog
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2.4.10.3 Save As PDF

With flexAnalysis 3.4 it is possible to save printouts directly as PDF files without the need
to first install a PDF printer driver, and use of a special flexAnalysis method. After the
menu entry has been selected theSave Report As dialog opens (see Figure 2-92).

Figure 2-92 Save Report As dialog

Click the browse button next to the PDF File Name field to select a location on the hard
drive where the PDF will be saved and append the file name. Printer properties and report
layout format can be defined in thePrinter andReport Layout group boxes.

It is possible to save PDF files for several spectra with the preinstalledmethods
ReportToPDF.* (for MS and LIFT spectra), and theBatch Process (see section
2.4.4.4) . The desired layout must be specified in the method script. Please contact
maldi.sw.support@bdal.de in case of questions.
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2.4.10.4 Save As HTML

To export results in html format, select Report > Save As HTML, click the browse button
next to theHTML File field to select a location on the hard drive where the html file will be
saved and append the file name. Report layout format can be defined in the Report
Layout group box.

Figure 2-93 Saving a report as an html document

2.4.10.5 Report Designer

The ReportDesigner command, and the corresponding toolbar button are used to
start the Bruker Daltonics ReportDesigner, which allows creating user- defined report
layouts. Existing layouts can bemodified and new ones can be set up.
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To create a new report layout, it is recommended not to modify the original layout but to
save the modified layout to a new file name. Otherwise, it is possible that your modified
layout may be overwritten by a later upgrade of the software.

Use the File > Open command in the ReportDesigner to open and, if needed, edit an
existing report layout or use the File > New command to set up a new layout.

Note For detailed information to work with the ReportDesigner, refer to themanuals
on the installation DVD.

Figure 2-94 ReportDesigner with loaded report layout

►► To create a new layout by modifying an existing layout

1. Click the ReportDesigner toolbar button or selectReport > ReportDesigner.

2. Select File > Open.

3. In the Open dialog navigate to the layout file (*.layout ) that will be used as a
template to create a new layout and clickOpen.

The selected layout is loaded.
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4. Modify the layout as desired.

5. Select File > Save As and save themodified layout to a new file name.

6. To close ReportDesigner, select File > Exit.

►► To create a new layout from scratch

1. Click the ReportDesigner toolbar button or selectReport > ReportDesigner.

2. Select File > New.

3. Set up the layout as desired.

4. Select File > Save As and save themodified layout to a new file name.

5. To close ReportDesigner, select File > Exit.

Report Layout files are installed in a folder namedReport Layouts, which is located in the
methods directory (normally D:\Methods\).

2.4.11 Tools Menu

Figure 2-95 Contents of the Tools menu
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Table 2-10 Features buttons of the Tools menu

Feature
button

Tools menu
commands Description

BioTools Sends a spectrum to BioTools.

PolyTools OpensPolyTools.

ProteinScape OpensProteinScape.

SmartFormula
Manually

Opens the SmartFormulaManually dialog.

Macro Editor Opens theMacro Editor.

Customize Customizesmenu bar and toolbar.

Options Customizes the spectrum display.

Colors Coloring specific screen elements.

Glycopeptides Refers to the results of the LIFTmethod
SearchGlycopeptides

Send Spectra to
ProteinScape

Opens the browser to select spectra to send to
ProteinScape.

2.4.11.1 BioTools

BioTools is a Bruker program for peak annotation of amino acids, whose spectra have
already been processed, for example, with flexAnalysis. BioTools uses these spectra and
peak lists for de novo sequencing on Internet searches.

The BioTools command is active if BioTools is installed (in a compatible version) on the
same computer and if an analysis is loaded andmarked in flexAnalysis.  The command is
used to save the currently active spectrum, open the BioTools program, and transfer the
spectrum to BioTools.

2.4.11.2 PolyTools

PolyTools is a program from Bruker for determination of monomers, end groups and
cations. Spectra must be already processed, for example, with flexAnalysis since
PolyTools needs these spectra and peak lists. If isotopes are resolved in the measured
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spectrum, lines belonging to the isotope distribution are identified and can be reduced to
amino isotopic series.

For every isotope series or the reduced monoisotopic series, the average molecular
weight, polydispersity, and degree of polymerization are determined. It is also possible to
enter repeat unit, end groups and cation manually, either in addition to or replacing the
values found automatically. New stick spectra calculated from all these data are displayed
together with the experimental spectrum for comparison. For more information, refer to
thePolyTools User Manual (# 205659).

ThePolyTools command is active if PolyTools is installed on the same computer.  After a
spectrum is loaded in flexAnalysis this command is used to open the PolyTools program
and to transfer the current spectrum.

2.4.11.3 ProteinScape

ProteinScape is a tool for storing, organizing and analyzing data generated during the
proteomicsworkflow.

The following basic tasks are supported:

l Data archiving and organization.

l Data viewing and reporting.

l In-depth data handling.

l Data analysis

ProteinScape is designed as a client-server platform with a simple web browser-based
user interface. It operates with industry- standard relational database systems like
Microsoft SQL Server.

When the ProteinScape psClient is installed on a computer, communication with
ProteinScape is possible. Every time flexControl or flexAnalysis is started, the user must
log in to ProteinScape, even if ProteinScape will not be used in the session. To avoid this,
the ProteinScape login can be deactivated.

Note Because the ProteinScape connection is essential for WARP-LC, it is not
possible to performWARP-LC runs if the ProteinScape login is deactivated.

To temporarily deactivate ProteinScape login, select Start > Programs > Bruker
Daltonics > Utilities > flexConfigurator and clickOK . The flex Configuration dialog
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(see Figure 2-96) will open. SelectMisc in the flexControl group box and selectNo in the
drop-down list to the right of ProteinScape Login to deactivate the ProteinScapelogin.

Figure 2-96 ProteinScape Login setting in the flex Configuration dialog

TheProteinScape command in the flexAnalysisToolsmenu is active if the ProteinScape
psClient is installed. This client must be downloaded from the ProteinScape server. The
ProteinScape command is used to send spectra to the ProteinScape database. For more
detailed information refer to theProteinScape User Manual.

The communication of flexAnalysis with ProteinScape:

l flexAnalysis 3.4 without psClient: No communication with ProteinScape.  The
command Tools > ProteinScape is unavailable.

l flexAnalysis 3.4 and psClient 3.0: The communication with ProteinScape 3.0 is
enabled. The dialog of psClient is available.

After the command has been executed, a dialog appears (see Figure 2-97).
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Figure 2-97 Send to ProteinScape dialog

Clicking the button in the left upper corner opens theExport to
ProteinScape dialog (see Figure 2-98), which is described in theProteinScape User
Manual. 
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Figure 2-98 Example of an Export to ProteinScape dialog

2.4.11.4 SmartFormula Manually

TheSmartFormula Manually command is used to calculate possible molecular formulas
of a measured m/z value taken from a highly resolved mass spectrum.  Patterns of a
calculated formulas can be preserved by saving them with the original spectrum as an
XML file.

The basic result elements of a SmartFormula operationmay be displayed in HTML format
and printed out.
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The calculation of elemental compositions of molecular (and fragment) ions need exact
mass determinations from a highly resolved mass spectrum.  The aim is to determine all
theoretically possible elemental compositions of amass, within a specified error tolerance.

The higher the measured mass, the more elemental compositions are possible.  For
example, up to a mass of 1000 Da approximately 66,000 compositions are theoretically
possible solely consisting of C, H, N and O.  For masses up to 2000 Da this value
increases up to 520,000.  Additional elements that may be found in the compositions will
extremely increase the number of compositions.

Because of this large number of possible combinations it is very time-consuming to trace
all of them and compare the resulting mass with the measured mass.  Therefore, the
number of solutions needs to be restricted.  One way is to limit the allowed ranges of the
occurring atoms.  The problem here is to set the limits in such a way that the correct
combination will not be excluded.  A better way is to use a more intelligent algorithm to
confine the number of combinations to be examined.

flexAnalysis uses an algorithm that is based on the fact that the integer part and the
fractional part of themolecular mass are linearly independent for organicmolecules up to a
molecular mass of about 1000.  This is used for combining C, H, N and O.  The other
elements, which usually occur in smaller numbers, are dealt with using the straightforward
try-and-error method.

The calculations used to generate molecular formulas are based on defined isotope
masses and abundances and atomic valences (see section A.3).

Selecting the SmartFormula Manually command opens the SmartFormula Manually
dialog (see Figure 2-99), which enables direct entry of an m/z value and definition of how
the calculation is carried out.
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Figure 2-99 Generate Molecular Formula dialog

Enter all the elements with their allowed minimum (Min) and maximum (Max) atom
numbers on which the chemical formula calculation is based. Formula calculation will start
at the formula entered inMin and stop at the formula entered inMax.

Note Form < 2000 the elements C, H, N, andOare considered implicitly.

Determining minimum and maximum formulas

l Generally a CHNO distribution will be calculated. To exclude one of these atoms
from the calculation, set it to ‘0’ (zero).  For example, to exclude nitrogen from a
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calculation, enter ‘N0’.

l Sorting of elements is not required.

l Brackets can be used to enter fixed atom ratios that should not be resolved.  For
example, when entering ‘[N3P3O6]CHF’ for Min and ‘[N3P3O6]C100H21F80’ for
Max, then calculation will use exactly 3 N, 3 P and 6O but 1 to 100 C, 1 to 21 H and
1 to 80 F.

l Chemical notation can be used. For example, ‘(CH3)6’ will be resolved to C6H18.

Unavailable field (Summary of Min/ Max rows above)

Lists the constraints to generate molecular formulas as specified in Min and Max, i.e. the
elements and minimum/maximum atoms numbers allowed.  Within these bounds
molecular formula calculation will occur.

Measured m/z

Enter the measured m/z value for which possible molecular formulas should be
calculated. Enter this value either by typing it in or by selecting the value in the Mass List
window.

Tolerance [ppm]

Enter the error tolerance for themass range to be analyzed in [ppm]. This is a range within
that flexAnalysis calculates the m/z value of the molecular formulas.  The default value
depends on the kind of the selected analysis. For FTMS analyses, the default value is
2 ppm, for ESI-TOF analyses 4 ppm and for all the other analyses 50 ppm.

Charge

For multiply charged ions, enter the assumed charge the ion of the Measured m/z
carries. The default value is 1. Please take into account the sign of the charge.  Themass
of the electron is not negligible for high-precision instruments. Switching between +1 and
–1makes a difference of two electrons or 1.1mDa, which represents 2 ppm for amolecule
of 548 Da.
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Auto locate monoisotopic peak

Select this option, if themonoisotopic peak corresponding to themeasured m/z should be
located automatically.  The algorithm will search to the left and right of the selected
measuredm/z for appropriate sum formulaswith their correspondingmonoisotopic peaks.

To use this option select the largest peak of the pattern.

If the search was successful the found formula(s) for the corresponding monoisotopic
peak(s) is entered into the results list. 

In formulas containing a monoisotopic peak, which is different from the selected peak, the
monoisotopicmass is slightly different by a few Da from the selectedmass. 

Themass error nevertheless is calculated for the selected peak and the exact theoretical
mass of that peak based on the formula from Alan L. Rockwood et al. (J.Am.Soc. Mass
Spectrom. 2004, 15, 12-21).

The default setting is cleared.

Maximum number of formulas

Enter themaximumnumber of molecular formulas to be calculated. The formulaswith the
smallest relative error based on themeasuredm/zwill be picked out. The default value is
200.

Check rings plus double bonds

Select this option if possible molecular formulas should be checked whether the number of
rings and double bonds present keeps within the bounds specified in Minimum and
Maximum. This will exclude all possible formulas with deviating double bond equivalence
numbers. Default is not selected.

The rings plus double bounds number is calculated from the number of atoms and their
valence:

Σ
R db+ =

n valence2 + × ( − 2)

2
atom atom

The valence of C and Si is 4, for N and P a valence of 3 is assumed. For O and S it is 2, for
H and the halogen atoms it is 1. For this limited set of atoms the equation simplifies to

R db n n n+ = − + + 1C H D F Cl Br I N P( )
1

2 ( , , , , , )
1

2 ( , )
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All the other elements are also considered.  Double bonds occurring with higher valence
states like 4 or 6 for sulfur cannot be taken into account as these valence states are
unknown.

Minimum

Enter the minimum number of rings plus double bonds to be contained in a molecular
formula. This number may be negative for protonated clusters. The default value is 0.

Maximum

Enter the maximum number of rings plus double bonds to be contained in the molecular
formula. The default value is 0.

Filter H/C element ratio

Check this option if possible molecular formulas should be filtered according to their ratio
of the elements H and C. Only formulas that comply with the H/C ratios specified in
Minimum H/C ratio andMaximum H/C ratiowill be displayed.

Electron configuration

Select the kind of electron configuration to be applied:

l Even: Generates onlymolecular formulas having an even electron configuration.

l Odd: Generates onlymolecular formulas having an odd electron configuration.

l Both (default setting): Generatesmolecular formulas of both electron
configurations.

The electron configuration is calculated under the assumption that molecular ions are
present. The electron configuration is even, if [n(atom) x valence(atom) + z(ion)] is even.
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Estimate carbon number

Select this option if the minimum number of carbon atoms to be used in generating
molecular formulas should be estimated by the program. The estimated number will be
entered in Min after generating formulas has been started. If Min already contains a
manually entered carbon number, the manually entered and the estimated number will be
compared and the higher of both carbon numbers will be used. This option should be set if
themonoisotopic peak could not be determined reliably, for instance, in compoundswith a
large number of carbon atoms or organometallic compounds.

For estimating the carbon number, the following assumptions aremade: The selectedm/z
value corresponds to them/z of themonoisotopic peak. The next peak that corresponds to
the isotopomer with one ^12C less and containing exactly one ^13C, is 1.003355 +-
distant from the selected m/z value. From the intensity ratio of both peaks, a carbon
number is estimated and rounded down. This number is then used as theminimum carbon
number in generating formulas.

Minimum C/H ratio

Enter theminimumC/H ratio to be applied. The default value is 0.

Maximum C/H ratio

Enter themaximumC/H ratio to be applied. The default value is 3.

Generate immediately

Select this option if SmartFormula generation should begin immediately when an m/z
value is chosen in theMass List window.

Generate

Generatesmolecular formulas for the mass range that is specified by the Measured m/z
and Tolerance values that meet the current parameter settings and enters them along
with corresponding data in the formula list.

If Show Pattern is already turned on, the pattern of the first formula in this list will be
displayed below the original spectrum and entered in the Analysis List as a subentry of the
original spectrum.
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Save Results

Allows saving themolecular formula results list in an XML file. Opens theSave As dialog.

(List of generated molecular formulas)

Lists the molecular formulas that have been calculated for the specified Measured m/z
value according to the current parameter settings.

For each formula the following set of data is calculated that includes for instance various
error values, rankings and statistical values:

#: Consecutive number of the formula.

Mol.Formula: Molecular formula.

m/z: Measuredm/z of the formula.

err [ppm] : Deviation between the measured mass and the theoretical mass of the
selected peak.

mSigma : Sigma value which combines the standard deviation of the masses and
intensities for all peaks. The value is given in [milliSigma].

rdb: number of rings and double bonds in the formula.

N rule: Indicateswhether the nitrogen rule is fulfilled.

e-: Indicates whether the electron configuration is even or odd. The electron configuration
is calculated under the assumption that we have molecular ions. The electron
configuration is even, if [n(atom) x valence(atom) + z(ion)] is even.

The formulas are sorted with increasing err [ppm] by default. Clicking a column header
sorts the list according to the column values.

Report

The Report button opens a HTML page containing the key information of the Generate
Molecular Formulas operation (Figure 2-100). 
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Figure 2-100 Example of a report

Show Pattern

The Show Pattern button allows comparison of the pattern of the measured mass and
the pattern of the selected formula (Figure 2-101) from the list of calculated masses
(Figure 2-99).

Applying this button adds the pattern of the selected formula into the Mass spectrum
window and the formula itself into the Analysis List window as a subentry of the original
spectrum.
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Figure 2-101 Comparing both existing and calculated mass

2.4.11.5 Macro Editor

flexAnalysis offers two different ways for an automatic processing: method scripts and
macros. Method scripts and macros are treated differently and designed in different
editors. The major difference is the range of application.  Method scripts are intended to
operate on the single analysis they are assigned to, while macros are independent of
specific analyses

The Macro Editor command is used to start the flexAnalysis Sax Basic Macro Editor
(see Figure 2-102).
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Figure 2-102 Sax Basic Macro Editor

l This editor is an interactive design environment for developing, testing, and
executing Sax Basic macros. Sax Basic is Visual Basic for Applications™
compatible. 

l flexAnalysis macros have a reference to Bruker flexAnalysis 3.4 Type Libraries,
whichmakes all flexAnalysis scripting objects available. 

l Please refer to the editor help from theHelpmenu in the flexAnalysis Macro
Editor for a detailed description on how to open, to create, and to execute macros
within themacro editor. 

2.4.11.6 Customize

The Customize command is used to vary the contents of the menu bar.  Additionally the
user can remove or add parts of the toolbar. These features are available on the tabs
Toolbars andCommands of theCustomize dialog. 
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Figure 2-103 Toolbars tab (displayed by default)

After opening, this dialog shows first the tab, which provides default palettes that contain
feature buttons to be temporarily removed or docked on to the GUI by applying the
corresponding check box (there is no access to the check boxmenu bar).

The button New opens the New Toolbar dialog in order to specify a name for the new
empty palette that will appear at once on theGraphical User Interface after closing with the
OK button. 

Figure 2-104 Creating a new Toolbar name

The symbols of the Commands tab (Figure 2-105) may be used to add one or more

functions to the new palette.  For instance, the user wants to add the Delete symbol .
To do so, switch to the Commands tab, open the category Edit and transport theDelete
symbol with the drag and drop to the new palette. 
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Figure 2-105 The Commands tab

In contrast to user-defined palettes, the defaults can only be removed from theGUI but not
deleted out of the program. On choosing a user-defined palette theReset button switches
toDelete.

2.4.11.7 Options

The Options command and the corresponding icon of the toolbar are used to
manipulate optional settings for flexAnalysis. 

The related dialog (see Figure 2-106) consists of four tabs,Display, Labels, Export, and
Calibration. 
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Figure 2-106 Option to specify the spectrum display

2.4.11.7.1 Display

The Local Maximum drawing optimization can be activated or deactivated in the
Drawing Optimization section. This feature is activated by default and less noise is
shown.
The stacked view can be configured in the Stacked View section. The parameter Angle
arranges spectra in a specific angular position in the display whereas the parameter
Offset specifies the distance between the displayed spectra. These parameters
determine how spectra appear in theStacked View of the display.

The parameter Windows of the section List View determines the number of windows
displayed in the List view. The information displayed for the spectra can be defined in the
Title drop-down box.

None: no spectrum information is shown
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Spectrum Info: sample name, chip, sample position, spectrum type, in case parent mass
and the processing state are shown

Spectrum File Path: the complete spectrum path is shown

Comment1: comment 1 is shown

Comment2: comment 2 is shown

Comment3: comment 3 is shown

2.4.11.7.2 Labels

Figure 2-107 Option to specify the appearance of the peak annotation

The Label tab (see Figure 2-107) contains two groups of radio buttons to specify how
peak labeling shall be performed.  

Density:

l Non-overlapping — prevents overlapping of the labels with the spectrum curve. 
Labels are not shown, if theywould overlap with the spectrum or neighboring labels.

l Non-overlapping with ticks—prevents overlapping of the labels and shows ticks
on the top of a labeled peak.

l Overlapping— overlaps the peak labels. All labels of all peaks of the mass list are
shown. 

l Ticks only— shows only ticks on the top of detected peaks.
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Orientation:

l Horizontal—displays the labels of them/z values horizontally.

l Vertical—displays the labels of them/z values vertically.

2.4.11.7.3 Export

Figure 2-108 Option to specify the numerical precision of the coordinates

The Export feature allows the operator to adjust the numerical precision of the x (mass)
and y (intensity) value. Choose these values as small as possible in order to save disk
space and processing time. The values chosen here are the number of digits used for each
data-point when exporting a mass spectrum. You can define with which resolution your
graphics are exported by choosing to use the screen resolution or by adjusting the DPI
value.
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2.4.11.7.4 Calibration

Figure 2-109 Option to specify the tolerance of the calibration strategy

Settings on this tab are relevant for internal recalibration (see section 2.4.5.1). TheNear
Neighbor tolerance applies to the Interactive calibration, whereas Default Calibrant is
used for Statistical Peptide calibration.

Also the global use of High Precision Calibration (HPC) can be activated in this dialog. 
HPC is a fine correction of the calibration in the mass range between 700 and 4000 Da
(see Appendix 1).

2.4.11.7.5 Application

Figure 2-110 Options to specify how the application should work
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Compatibility mode for deprecated processing parameters

There are processing parameters (e.g. ConvexHull), which were offered in older
Compass for flex versions, but which are no longer under development and which are no
longer supported. They are substituted by other ones. Therefore usually they are disabled
in the GUI. Nevertheless there might be use cases where it still makes sense to use these
deprecated parameters. You then have the possibility to choose whether the deprecated
parameters should be enabled for this session or always. If you activate them for this
session, the next time you start flexAnalysis, the parameters are disabled again.

In case an error message with the keyword deprecated appears youmay either activate
the compatibility mode (for most use cases not recommended!) or you may repair the
method/spectrum parameter. How to do this is explained in section 2.2 of the document
Quickstart_Deprecated_Parameters.pdf,available on your installation DVD.

Analysis List

With these settings you can change the behavior of the analysis list window (the tree
view).

No Peaks: only the analysis and spectra lines are shown (conventional view)

Peaks with SmartFormula: the conventional view is expanded by the peaks, which have
been created with the SmartFormula. This is the default setting.

Figure 2-111 Analysis List window, which shows SmartFormulas

All Peaks: all peaks, the peaks created with SmartFormula and the peaks of the peak list,
are shown
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Figure 2-112 Analysis List window, which shows all peaks

2.4.11.7.6 SmartFormula

Figure 2-113 Options to specify the SmartFormula

In this dialog you can specify how the SmartFormula Manually dialog should open so
that there is no need to change the basic settings every time (see section 2.4.11.4).
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2.4.11.7.7 Updates

Figure 2-114 Options to specify updates

This dialog offers the possibility to be automatically informed when an update/upgrade of
the software is available. If connected to the Internet the Compass 1.4 software checks for
updates in configurable intervals: with every program start,daily, weekly, monthly, never.
The displayed information will contain the respective contact address.

This feature opens a passive ftp connection to ftp.bdal.de, so a firewall (if present) needs
to be configured accordingly. This is done by the installation for the firewall integrated into
theWindows operating systems.

2.4.11.8 Colors

The Colors command is used to assign colors to particular screen elements in the Mass
Spectrumwindow. Several screen elements are offered. New options to this flexAnalysis
version areBackground Peak Label andAnnotation Label.
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If peaks are recognized as background peaks (Identify Backgrounds macro) but have
not yet been deleted from the peak list they will be shown colored with the color selected
here. The annotations added via the new Annotation tool are also displayed in the color
selected in this dialog.

Figure 2-115 Colors dialog box

2.4.11.9 Glycopeptides

For detailed information, please see the tutorial Quickstart_Glycopeptides.pdf.

2.4.11.10 Send Spectra to ProteinScape

The Send Spectra to ProteinScape macro is used to send data to a ProteinScape
server. Selecting this command opens theSpectrum Browser to select and load data.
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2.4.12 Window Menu

Figure 2-116 Contents of the Window menu

Table 2-11 Features of the Window menu

Feature
button

Window menu
commands Shortcut Description

Analysis List ALT+1 Shows/Hides the Analysis List
Window.

Mass Spectrum ALT+2 Shows/Hides theMass Spectrum
Window.

Mass List ALT+3 Shows/Hides theMass List Window.

Sequence List ALT+4 Shows/Hides the Sequence List
Window

SmartFormula List ALT+5 Shows/Hides the SmartFormula List
Window

2.4.12.1 Analysis List

TheAnalysis List command, the corresponding icon of the toolbar , and the short cut
(ALT+1) display or remove the analysis list from theGUI.

2.4.12.2 Mass Spectrum

The Mass Spectrum command, the corresponding icon of the toolbar , or the short
cut (ALT+2) toggle theMass Spectrumwindow and the Bruker symbol. 
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2.4.12.3 Mass List

The Mass List command, the corresponding icon of the toolbar , and the short cut
(ALT+3) display or hide the mass list from theGUI. When the Mass List window is shown,
the tool button shown in front of this command is highlighted.

2.4.12.4 Sequence List

TheSequence List command, the corresponding icon of the toolbar and the shortcut
(ALT+4) fill this window with sequence tags, which can be created with the annotation
feature (see section 2.4.6). If there is a gap in the sequence tag, a new entry with the next
abbreviation of the currently chosen annotation will occur in this window. A sequence list
can be saved together with a spectrum. After saving and closing a spectrum, the sequence
list will be reloaded when the spectrum is reopened.

2.4.12.5 SmartFormula List

The SmartFormula List command, the corresponding icon of the toolbar and the
shortcut (ALT+5) display or hide themolecular formula list in the GUI. A SmartFormula list
can be saved together with a spectrum. After saving and closing a spectrum, the
SmartFormula list will be reloaded when the spectrum is reopened.

2.4.13 Compass Menu

Figure 2-117 Content of the Compass menu
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Table 2-12 Features of the Compass menu

Compass menu
commands Shortcut Description

License Enter the License number here.

Operator Changes the operator.

Lock all
Applications

CTRL+ALT+
K

Locks all programs in case the Compass Security
Pack is installed.

Compass Desktop F11 Opens the CompassDesktop.

FlexControl CTRL+F11 Opens flexControl.

BioTools ALT+ F12 Opens BioTools.

Audit Trail Viewer Opens the Audit Trail Viewer in case the Compass
Security Pack is installed.

2.4.13.1 License

The License command is used to open the Bruker Daltonics LicenseManager dialog
box for viewing or adding/removing licenses for Bruker products. The LicenseManager
looks the same in nearly all programs. It is not necessary to enter a license for a special
Bruker program in the respective program; it can be entered via the LicenseManager of
other Bruker programs.
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Figure 2-118 The LicenseManager

2.4.13.2 Operator

The Operator command is used to log on as a new operator. The new operator name
appears in the status bar at the bottom of the GUI. If the Bruker Daltonics
UserManagement is installed, a password is requested.

If a user logs on with theOperator command the user automatically changes for all other
Bruker programs that are currently open and running with UserManagement. If
flexControl is running, it asks the user for a new acquisitionmethod.

2.4.13.3 Lock All Applications

The Lock All Applications command and the shortcut (CTRL+ALT+K) lock all Bruker
applications that are currently open and opens the Unlock dialog. The duration depends
on the lock-time defined in UserManagement.

If one program is locked (manually or via timeout), all programs that run with the
UserManagement are locked, since they all use the sameUserManagement server. In this
case it is necessary to unlock only one program. A locked program can only be unlocked
by the user who locked it or the UserManagement administrator.

Note The Lock All Applications command is only available if Bruker Daltonics
UserManagement is installed.
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2.4.13.4 Compass Desktop

TheCompass Desktop command opens the so called Bruker Compass. ThisGUI offers
access to installed Bruker programs under Acquisition, Processing, and Data
Interpretation, and their user manuals.

Figure 2-119 Compass Desktop GUI

2.4.13.5 flexControl

The flexControl command is used to open flexControl or bring it to front if it is already
open. Data transfer cannot be performed using this or any other command.

2.4.13.6 BioTools

The BioTools command is used to open BioTools or bring it to front if it is already open.
Data transfer — for example, sending a spectrum to BioTools — cannot be performed
using this command. To send spectra to BioTools use theBioTools command in the
Toolsmenu (see section 2.4.11.1).
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2.4.13.7 Audit Trail Viewer

The Audit Trail Viewer command opens the Bruker Daltonics AuditTrailViewer
dialog. This command is only available if the Bruker UserManagement is installed.

Figure 2-120 Audit Trail Viewer

2.4.14 Help Menu

Figure 2-121 Contents of the Help menu
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Table 2-13 Features of the Help menu

Feature
button Help menu commands Shortcut Description

Help Topics F1 Opens the help file.

About Bruker Daltonics
flexAnalysis

Opens the About
Window

2.4.14.1 Help Topics

TheHelp Topics command, the corresponding icon of the toolbar, and the short cut
(F1) open the flexAnalysis online-help to get information about specific topics. 

2.4.14.2 About Bruker Daltonics flexAnalysis

This command opens the About dialog (see Figure 2-122) that displays the version
number of your flexAnalysis version with the copyright notice, the user-specific license
information, and contact information of Bruker DaltonikGmbH.

Figure 2-122 About dialog
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2.5 Window Areas

2.5.1 Analysis List Window

The Analysis List window (or tree view) is used to display one or more selected analyses
and their related spectra. Analyses can be arranged by dragging & dropping.

The tree view (see Figure 2-123)of flexAnalysis 3.4 offers several improvements over
previous versions.

Figure 2-123 flexAnalysis tree view

Each icon reflects the color of the respective spectrum. When a spectrum is expanded,
four sections are shown, allowing fast access to the spectrum parameters, the method,
and the new calibration information window (see Figure 2-16).

2.5.2 Mass Spectrum Window

TheMass Spectrumwindow (or display) is used to display a spectrum or spectra of one or
more analyses selected in the Analysis List window. 

When a spectrum is displayed and themouse pointer is within the window boundaries, two
interactivemouse pointer modes are available.

Editmode (see section 2.4.3.2)àmouse pointer + CTRL .

Zoommode (see section 2.4.9.7)àmouse pointer + SHIFT

Switch between modes by pressing either CTRL or SHIFT (the mouse pointer must be in
theMass Spectrumwindow). 
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2.5.3 Mass List Window

The Mass List window (or peak list) displays masses and peak parameters of a selected
spectrum in the Mass Spectrum window or the Analysis List window. Only onemass list is
displayed at a time. This list layout can be customized (see section 2.4.7.5.4).

2.5.4 Sequence List Window

The Sequence List window displays the annotations (mass differences) and sequences of
a spectrum selected in the Analysis List window.

2.5.5 SmartFormula List Window

The Molecular Formula Result List window displays the SmartFormula results from a
spectrum selected in the Analysis List window.

2.6 flexAnalysis Window Shortcut Menus

Right-clicking in a flexAnalysis window opens a menuwith shortcuts to menu commands.
For more information on the individual commands, see the description in the respective
menu section.

2.6.1 Analysis List Window (Tree View) Shortcut Menu

Clicking within the body of the Analysis List window opens a shortcut menu containing
commands for handling data and changing the appearance of the window (see Figure 2-
124).
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Figure 2-124 Tree view shortcut menu options

2.6.2 Mass Spectrum Window (Display View) Shortcut Menu

Clicking within the body of the Mass Spectrum window opens a shortcut menu containing
commands for manipulating spectra (see Figure 2-125).
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Figure 2-125 Display view shortcut menu options

Clicking next to the x- or y-axis opens a shortcut menu for altering the axis scales and
labeling (see Figure 2-126).

Figure 2-126 Spectrum axis shortcut menu
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Hide Y-axis

Show/Hide the intensity (y) axis.

Axis Font

Opens a dialog, where you can change font, font style and size of the x-/ y-axis and the
spectra labeling.

2.6.3 Mass List (Peak List) View Shortcut Menu

Clicking on an entry in an existingmass list within the Mass List window opens a shortcut
menu containing commands for handlingmass control lists (see Figure 2-127).

Figure 2-127 Mass List window shortcut menu options

For information on theAdd to MS/MS command, see section 2.4.3.5.

Clicking within the Mass List window beneath an existing mass list opens an alternative
shortcut menu (see Figure 2-128).
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Figure 2-128 Alternative Mass List window shortcut menu options

A third shortcut menu is opened by clicking within the empty Mass List window (see Figure
2-129).

Figure 2-129 Empty Mass List window shortcut menu options

Show/Show always

Depending on the chosen peak picking algorithm to label the peak of interest different
things can be visualized with the Show/Show always function. If SNAP is used, the
isotopic distribution of the fitted peak is shown as an area. WithCentroid or Sum aGauss
curve of the molecular weight is shown as area. With the Show function only one peak of
interest is shown. If you activate the Show always function, you can choose different
peaks in themass list window and each time the corresponding area is shown.
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Note The calculatedSNAP areas can only be shown as long as the spectrum is not
closed. If the spectrum has been closed and reopened only a line is shown,
which shows the isotopic distribution of the fitted peak. If you want to visualize
the area again, the peak list has to be recalculated, this means you have to
select theMass List > Find orMass List > Edit command again.

2.7 Pointers and Interactive Modes

Different mouse pointers are available in flexAnalysis, each has a specific function that
facilitates using the software.

Data Pointer

The data pointer moves with the arrow pointer of the mouse within the Mass Spectrum
window.  In the case of two or more spectra the data pointer resides on the last generated
spectrum.  The m/z value and the related intensity of the current position of the data
pointer are displayed at the right edge of the status bar.

Pointers for Direct Manipulation

HorizontalWindow Border : (docked windows) (undocked windows)

These pointers are used to change the height of windows and are displayed when the
mouse pointer is positioned on the upper or lower border.

VerticalWindow Border : (docked windows) (undocked windows)

These pointers are used to change the width of windows and are displayed when the
mouse pointer is positioned on the left or right border.

Horizontal Scaling:

This pointer appears below the x-axis of the Mass Spectrum window and is used to shift
the spectrum and the scale horizontally. 

Vertical Scaling:

This pointer appears beside the y-axis of theMass Spectrum window and is used to shift
the spectrum and the scale vertically. 
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ColumnWidth:

This pointer is used to change the width of columns, such as those in the Mass List
window, and is displayed when themouse pointer is positioned on the left or right border of
a column header.

Pick:

This pointer is used to directly select amass spectrum in theMass Spectrum window.  It is
displayed when the mouse pointer is positioned within 3 pixels of a data point of an
unselectedmass spectrum.

Interaction Mode Mouse Pointers

Zoom In:

This pointer is used to zoom the display range of a data window.  It is displayed when the
Zoom In mode is active and when the mouse pointer is positioned on a data window's
display. 

Access: Mouse pointer + SHIFTàZoommode (see section 2.4.9.6).

Edit Mass List Pointers

These pointers are used to add a peak or to delete a peak from theMass List in a spectrum
displayed in the Mass Spectrum window. They are displayed in addition to the Data
pointer, when the Edit Mass List mode is active and the mouse pointer is positioned on
the selected spectrum. 

The pointer that is displayed at any given time depends on the actual position of the Data
pointer.

The Delete pointer appears when the Data pointer is positioned on a data point that
belongs to amass peak already present in the spectrum'smass list.

The Add pointer appears when the Data pointer is positioned on a data point whose
mass peak is not yet present in theMass List window. 

Access: Mouse pointer + CTRLàEdit mode (see section 2.4.3.2). 
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The Internal Calibration pointer: is used for internal calibration of analysis mass
spectra.  It is used to manually select a peak from a mass spectrum displayed in theMass
Spectrumwindow and to assign it to a selected reference mass.  It is displayed in addition
to the Data pointer when the Internal command from the Tools menu is active and the
mouse pointer is positioned on the selectedmass spectrum.

2.8 flex Data Converter

The flex Data Converter is an utility for converting data sets between the traditional
XMass data format and the new Container data format (see section 2.4.1.2) . The
converter creates a copy of the data set; the original data set is not modified.

The flex Data Converter is launched from the Start menu under Programs > Bruker
Daltonics > Utilities > flex Data Converter.

The flex Data Converter runs as a wizard with the following steps:

1. Welcome page (see Figure 2-130).

2. Select Spectra page (see Figure 2-131). ClickBrowse to open theSpectrum
Browser dialog and select the desired spectra.

3. Select Destination page (see Figure 2-132). Choose the destination directory here.

4. Select Format page (see Figure 2-133). Specify the requested output format: XMass
or Container.

5. Conversion Options page (see Figure 2-134). By default, the data converter tries to
retain the current processing state of the spectra. The options here can be used to
undo certain processing steps.

6. Summary page (see Figure 2-135). This page lists the selected options. ClickingStart
starts the conversion.

7. Convert Spectra page (see Figure 2-136). This page displays the progress of the
conversion.

8. Conversion Summary page (see Figure 2-137). Shown after conversion completion,
when the converted data set is ready for use.
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Figure 2-130 flex Data Converter wizard Welcome page
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Figure 2-131 flex Data Converter wizard Select Spectra page
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Figure 2-132 flex Data Converter wizard Select Destination page
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Figure 2-133 flex Data Converter wizard Select File Format page
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Figure 2-134 flex Data Converter wizard Set Conversion Options page
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Figure 2-135 flex Data Converter wizard Summary page
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Figure 2-136 flex Data Converter wizard Convert Spectra page
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Figure 2-137 flex Data Converter wizard Conversion Summary page
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Appendix A —Calibration

A.1 Calibration Procedures

The following paragraphs summarize the three different recalibration procedures.

A.1.1 Performing an Internal Calibration Using the Statistical
Peptide Calibration Feature

1. Select exactly one spectrum in the Analysis List window. 

Make sure that this spectrum is displayed in theMass List window.

2. Open the Internal Mass Spectrum Calibration dialog and selectStatistical
peptide (if not already selected).

3. Read theGolden Rules for Statistical Calibrations (see section 2.4.5.1.1).

4. ClickCalibrate.

5. If the new calibration is satisfactory, clickOK.

A.1.2 Performing an Internal Calibration Using the Automatic
Assignment Feature

1. Select exactly one spectrum in the Analysis List window. 

Make sure that this spectrum is displayed in theMass List window.

2. Open the Internal Mass Spectrum Calibration dialog, select Interactive and
choose a calibration list containing themasses the calibrants in the spectrum.

3. Click on a row in the calibration list that contains a calibrant present in the spectrum.

The row is marked with a red arrow indicating that the calibrant is in use, but not
assigned. If the zoom range setting is correct, the calibrant peakwill be displayed in the
Mass Spectrumwindow.

4. Select the calibrant peak in theMass Spectrumwindow by clicking to the left of the
peak.
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If the assignment was successful the Current mass entry and the Error entry are
filled with the calculated values and the row is marked with a green arrow. The
calibration constants displayed in the dialog (c0 – c2) are also updated. 

Any improvement in the calibration due to the new calculation can be evaluated by
checking the standard deviation values before and after calibration. The calibration
constants can be checked by clickingProperties.

5. Repeat steps 3 and 4 until all entries in the referencemass list or all the calibrant peaks
in the spectrum have been assigned.

To remove a calibration assignment from the table, click the corresponding mass. Note
that the buttonClear removes all the previouslymatchedmasses!

A.2 High-Precision Polynomial Calibration (HPC)

A.2.1 What is HPC?

HPC is a fine correction of the calibration in the mass range between 700 and 4000 Da
available on ultraflexmass spectrometers.

The use of any kind of pulsed ion extraction in time of flight mass spectrometry distorts the
linear relationship between m/z and the square of the ion flight time.  By empirically fitting
the residual deviation (few ppm) from the ideal quadratic calibration by a high order
polynomial (HPC) one can significantly increase mass accuracy, esp. for masses below
1 kDa. For details please refer to Gobom J. et al., Anal. Chem. 2002, 74, 3915-3923.

A.2.2 Using HPC

ultraflex instruments (production 4/03 or later) are equipped with a dedicated HPC
flexControl acquisition method called Proteomics_HPC.par .  This method preset at
the factory contains all relevant HPC parameters andmust not be changed.  If you change
any of the instrument voltages or the deflection pulser settings the HPC method becomes
invalid!

Use Proteomics_HPC.par for all standard proteomics applications and the HPC
correction is automatically performed in flexControl3.x and flexAnalysis3.x without any
user interaction for all spectra acquired with thismethod.  Use the common calibration and
mass list generation procedures for those spectra.
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Note HPC only eliminates the deviations from the quadratic calibration function, and
does not replace a good quadratic calibration.

A.2.1 Checking HPC Performance

HPC performance can be checked by acquiring mass spectra of samples with about 10
known peaks in themass range 750 Da - 3500 Da using the HPC method Proteomics_
HPC.par. Themost relevant HPC correction takes place below 1 kDa, and it is therefore
it is essential that the sample contains calibrants between 750 Da and 1000 Da.  We
recommend using the Bruker PeptideCalibration standard supplemented with Bradykinin
(fragment 1-7, 757 Da) to cover the low mass range.

After mass spectra acquisition, perform internal quadratic calibrations with flexAnalysis
using the known 10 peaks as calibrants. If HPC is switched on (select check box in
flexAnalysis) typical mean mass errors of about 3–5 ppm are achieved. If the HPC check
box is cleared, results are significantly worse (about 10 ppm).

A.3 Table of Valences

Valences used for calculation of ring and double bonds, electron configuration and
nitrogen rule in the Tools > Generate Formula command are given below.

Atom Valence Atom Valence Atom Valence Atom Valence

H 1 Ni 2 La 3 Rn 0

D 1 Cu 1 Ce 4 Fr 1

T 1 Zn 2 Pr 3 Ra 2

He 0 Ga 3 Nd 3 Ac 3

Li 1 Ge 4 Pm 3 Th 4

Be 2 As 3 Sm 2 Pa 4

B 3 Se 2 Eu 2 U 3

C 4 Br 1 Gd 3 Np 3

N 3 Kr 0 Tb 3 Pu 3

O 2 Rb 1 Dy 3 Am 3
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Atom Valence Atom Valence Atom Valence Atom Valence

F 1 Sr 2 Ho 3 Cm 3

Ne 0 Y 3 Er 3 Bk 3

Na 1 Zr 4 Tm 3 Cf 3

Mg 2 Nb 5 Yb 2 Es 3

Al 3 Mo 6 Lu 3 Fm 3

Si 4 Tc 4 Hf 4 Md 3

P 3 Ru 3 Ta 5 No 2

S 2 Rh 3 W 6 Lr 3

Cl 1 Pd 2 Re 4 Rf 0

Ar 0 Ag 1 Os 3 Db 0

K 1 Cd 2 Ir 3 Sg 0

Ca 2 In 3 Pt 2 Bh 0

Sc 3 Sn 4 Au 1 Hs 0

Ti 4 Sb 5 Hg 2 Mt 0

V 5 Te 2 Tl 3 Ds 0

Cr 3 I 1 Pb 4 Uuu 0

Mn 2 Xe 0 Bi 5 Uub 0

Fe 2 Cs 1 Po 2 Uuq 0

Co 2 Ba 2 At 1 Uuh 0
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Index
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About command 151

Analysis List command 145

Analysis Window 152

Auto-Scaling command 109
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Batch Process command 52
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Change Parameters command 106

Clear command 44

Clear Range Selection command 40

Close command 27

Color command 39

Colors command 143

Compass Security Pack 13

Copy Calibration command 71

Copy command 37

Customize command 134

D

Default Color command 40

Delete command 38

Delete Segment Spectra command 107

Distance in Masses command 49

E

Edit Building Blocks command (Annotation
menu)

77

Edit command 43

Edit Parameters command 83

Edit Script command 102

Exit command 34

Export command 31
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Files for recalibration 26

Filter Background Peaks command 49

Find command 42

H

Help Topics command 151

High Precision Calibration 140, 170-171

Horizontal Auto-Scaling command 110

I

Installation 15

Interactive modes 152

Internal Calibrate command 60

Internal calibration procedure 169

L

License command 148-149

Lock all Applications command 148
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M

Macro Editor command 133

Mass List command 146

Mass List Window 153

Mass Spectrum Command 145

Mass Spectrum Window 152

Menu Bar 21

Microsoft .NET Framework 13

O

Open command 80

Operator command 148

Options command 136

P

Paste Segment Spectra command 104

Paste Special command 37

PolyTools command 120

Print command 115

Print Preview command 113

Process Spectra command 58

ProteinScape command 121

Purpose of the software 13

R

Range Selection command 40

Redo Zooming command 111

Replace Calibration command 71

Report Designer command 117

Rules for statistical calibration 69

Run Script command 83

S

Save All command 29

Save As command 29, 82

Save As HTML command 117

Save As PDF command 116

Save command 82

Scale to Entire Spectrum command 110

Select All command 38

Select Default command 103

Select None command 38

Sequence List command 146

Set Display Range command 110

SmartFormula List command 146

SmartFormula Manually command 124

Smooth Mass spectrum command 52

Statistical peptide calibration procedure 169

Status Bar command 113

Statusbar 20

Subtract Mass Spectrum Baseline command 52

Support 151

T

Title bar 20

Toolbars command 112
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U

Undo All Processing command 52

Undo Zooming command 111

User management 13

V

View Analysis command 39

View Spectrum command 39

W

Window menu 145

Z

Zoom command 111

Zoom X command 111
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